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1 Introduction  

1.1 Scope and Purpose 

The 470A Myofibril AFM Force Transducer uses an atomic force microscope cantilever beam and a 

precision optical system to measure the nano-Newton forces resulting from myofibril contraction.  

Physiologists now have a reliable and accurate way to measure the contractile properties of a bundle of 

myofibrils or even a single myofibril. 

This manual outlines the setup, operation and troubleshooting necessary for determining the mechanical 

properties of fiber-like structures using the 470A AFM transducer.  Muscle myofibrils are the primary 

tissue type that the 470A was designed to measure.  These are fiber-like structures 1-2 µm in diameter 

that organize to cause muscle contraction.  

Designating direction in this manual is done through the point of view of the user. Hence, left indicates 

the left direction as seen by the user and right indicates the right direction as seen by the user. 

 

Figure 1 470A Myofibril AFM Force Transducer Head with 821A Manipulators 
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Figure 2 470A Controller 
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2 Quick Start Guide 

This quick start guide will provide you with basic information that will allow you to get your new 470A 

Myofibril AFM Force Transducer up and running as quickly as possible.  

 

2.1 Instrument Setup  

Your new 470A AFM force transducer was shipped in three boxes.  Unpack the boxes and check the 

contents against the list provided below.  If there are any issues with what you received, please contact 

Aurora Scientific as soon as possible.   

Item  Description 

Box 1  

470A AFM Transducer Controller Main controller including power supply pre-set to the 

power used in your country, control electronics are in a 

2U, ½-rack, rack-mountable enclosure.  Fiber optic for 

laser is fragile, take care when unpacking. 

Box 2  

470A Accessories Accessories including power cord, 8-pin miniDIN sensor 

cable, spare cover slips for bottom of bath, spare AFM 

Cantilever beams, periscope assembly, Bath assembly, 

AFM cantilever mount assembly and 340A piezo length 

controller mount assembly, mounting screws and tools. 

Box 3  

470A AFM Transducer Head 470A AFM transducer head complete with 821A XYZ 

motorized stage assemblies, push-button stage 

controls, microscope mount assembly,  

Table 1 Items included with a 470A AFM Force Transducer 

 

2.1.1 Mounting the 470A AFM Force Transducer   

1. The 470A is mounted to an inverted microscope using the rear most bolt holes that hold the 

microscope stage to the microscope.  Using the 4mm Allen key, remove the rear two screws, 

located near the condenser pillar, that hold the XY stage to the main microscope structure.   

2. Locate the two M5x30mm socket head cap screws located in the accessory package and place 

these screws in the two holes provided in the microscope mount assembly near the back of the 

470A head.  Carefully place the 470A AFM transducer head assembly on the microscope and line 

up the mounting holes with the rear stage mounting holes.  Tighten the two screws loosely so 

that the position of the 470A microscope mount can be fine adjusted prior to final tightening.   

3. Locate the 470A periscope subassembly in the accessories and place it on the front of the 470A 

head.  Handle the periscope subassembly carefully as the glass periscope can be damaged quite 

easily.  Protect it from dust and dirt and clean it according to the maintenance instructions at the 
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end of this manual.  The periscope subassembly is held on using magnets located in the head.  

You will notice three set screws with ball ends protruding from the back of the periscope 

subassembly.  These balls locate in sockets provided on the head.  Mount the periscope 

subassembly on the head ensuring the periscope is positioned so that the laser exit face is below 

the head. 

4. Observe the end of the periscope through the microscope eyepieces while using a 4X objective.  

Manually reposition the microscope mount subassembly so that the periscope is centered in the 

side-to-side direction within the field of view of the microscope.  Gently tighten the two M5 

screws holding the 470A microscope mount to the microscope.  Check the positioning of the 

periscope again, readjust the mount if required, and continue to tighten the two mounting 

screws.  

5. Switch to a 10X objective and observe the end of the periscope again.  The periscope should be 

located about 600µm from centre of the field of view.  Use the fine adjustment screws on the 

front side of the microscope mounting assembly to fine position the 470A head in the field of 

view.  To do this first loosen the clamp screws on either side of the 470A head that hold the head 

onto the microscope mount plate.  Screw the fine adjustment screws in or out to reposition the 

470A and then retighten the clamp screws, see Figure 3.    

6. The 901D HVSL camera system can be used to assist you in positioning the periscope with respect 

to the optical axis of the microscope.  Run the HVSL program and ensure it is calibrated for the 

selected objective.  Now draw an ROI box from the centre of the image to the face of the 

periscope.  The size readout in the top right of the HVSL screen will tell you the size of the box 

and thus the distance of the periscope from the centerline of the microscope.   
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Figure 3 Top View of 470A Mounted to Microscope 

 

2.1.2 Installing the Bath   

1. The 470A bath plate will arrive with a 22mm square, No. 1, cover slip installed.  If this cover slip is 

damaged or needs to be replaced, then follow the replacement procedure located in the 

maintenance section of this manual, Section 4.1.1.  

2. The 470A head is built on a base that can be tilted up to provide clear access to the tissue bath.  

In order to install the bath, first tip the 470A head up as high as it will go.  To do this locate the 

horizontally mounted tilt knob that is on the back-right side of the 470A microscope mount. Pull 

the tilt knob out and raise the 470A head up.  Release the tilt knob and the head will lock at one 

of three angles (15°, 23° or 30°).  We suggest you tip the 470A head up as high as it will go.  On 

some microscopes you will not be able to reach the 30° location, in that case, set the 470A head 

at 23° instead.  Note: you may need to tip the condenser pillar back and out of the way or, for 

microscopes with fixed pillars, remove the condenser to make clearance for the 470A to be tilted 

up. 
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3. Remove any plates that may be mounted to the XY stage of the microscope. This should leave the 

stage plate with either a 108mm (4.25”) diameter hole in the centre into which you can place the 

470A round bath plate or a rectangular cutout into which you can place the 470A rectangular 

bath plate.  Orient the bath plate so the long axis of the plate is across the stage.  You can orient 

the bath plate with the temperature control inlet and outlet hose connectors either facing 

towards the right or the left, depending on how you have set up the rest of your equipment.  

4. Attach the temperature control lines to the bath plate.  The bath plate’s temperature is 

controlled by circulating liquid through the bath plate via the two brass fittings.  Using the tubing 

provided in the accessory kit and the quick-connect tube fittings, attach a lab circulator (supplied 

by the researcher) to the two hoses attached to the bath.  These hoses are terminated with dry-

break, quick-connect fittings that can be plugged and unplugged without spilling liquid.  Once all 

tubes are connected, set the circulator to the desired operating temperature and start the 

circulator.   

5. Attach the bath plate suction line to a peristaltic pump, or other suction source (supplied by the 

researcher).  The bath plate is now set up and ready for use. 

2.1.3 Attach the Piezo Motor   

The 340A piezo motor is required to control the length of the myofibril (muscle tissue).  The 340A 

mounts on the left XYZ stage using the rotatable probe clamp provided.  Use the following procedure 

to mount the piezo motor.  Refer to the 340A Instruction Manual for proper care and use of the 340A 

Piezo Length Controller.  

1. Align the arrows on the plug and receptacle and then plug the motor cable onto the piezo motor.  

The connector should “click” into place.  

2. Loosen the rotation control knob on the side of the left probe clamp and rotate the clamp so that 

the mounting surface is horizontal.  Lightly tighten the knob so that the clamp doesn’t rotate 

unexpectedly.  

3. Loosen the clamp knob enough to insert the piezo motor into the rotatable probe clamp.  Insert 

the motor with the pipette end going in first and from the left side of the clamp.  Note: if the 

piezo motor will hit the 470A periscope then use the left XYZ stages to move the motor mount to 

a safe location.  

4. Rotate the motor within the clamp so that the white arrow on the connector, and the logo on the 

motor, point towards the front of the microscope.  Tighten the clamp knob enough to hold the 

piezo motor without any movement, do not overtighten.   

5. Loosen the rotation knob and rotate the clamp so that the motor goes into the bath.  When the 

motor is at the correct angle re-tighten the rotation knob.  Take care not to rotate the clamp so 

much as to cause the pipette to strike the bottom of the bath.   

6. If required, loosen the clamp knob again and slide the piezo motor back and forth in the clamp 

until the pipette tip is the correct amount into the bath.  Note: the XYZ stages control the fine 

position of the tip of the motor within the bath.  You only need to get the motor located close 

enough to the working location to then use the XYZ positioners.  You do not need to use the 

rotatable probe clamp to obtain the final position of the motor. 

7. Plug the other end of the motor cable into the front panel connector on the 340A piezo motor 

controller.   
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8. Attach a tie-wrap anchor to the probe holder, or to the face of the left Z axis stage, using the 

double-sided tape applied to the back of the anchor.  Note: ensure the anchor is attached to a 

part of the apparatus that moves with the motor. 

9. Tie-wrap the motor cable to the anchor to strain relief the motor from being affected by cable 

movement.  Form a small loop in the cable between the strain relief and the end of the motor. 

10. Switch the 340A controller on and use the Run/Stop switch to put the motor in Run mode. Focus 

the microscope on the tip of the piezo motor.  Using the front panel Offset knob move the motor 

back and forth.  Observe the motion of the tip and whether the tip stays in focus as it moves.  The 

motor only moves in one plane but the orientation of the motor in the clamp determines 

whether this motion is in a horizontal plane or not.  The motor must be rotated to ensure that 

the tip moves horizontally in the field of view.  If the tip goes in and out of focus this means that 

the motor must be rotated in the holder as the angle is incorrect and the tip is moving 

horizontally and also vertically.  Adjust the rotation of the motor within the clamp until the tip 

stays in focus as it moves back and forth.  Note: you can also use the 600A software to drive the 

motor position during this step.  

11. Calibrate the motor before use. 

2.1.4 Setting the Periscope Vertical Height in the Bath   

1. Before lowering the 470A head into the operating position it is important to ensure: a) the 

periscope will not hit the side of the bath plate during lowering and b) the periscope will not hit 

the cover slip on the bottom of the bath.   

2. To ensure the periscope will not strike the bath plate, use the microscope’s XY stage controls to 

position the centre of the bath plate over the centerline of the objective.  The 470A has been 

mounted and oriented with respect to the optical axis of the microscope and as such, if the bath 

plate is centered on the objective then the periscope will not hit the bath when the 470A head is 

lowered. 

3. To ensure the periscope will not hit the cover slip, locate the fine adjustment knob mounted 

vertically above the tilt knob.  This knob adjusts the vertical height of the periscope in the bath.  

Locate the brass lock-nut located on the height adjustment screw and loosen it.  Turn the black 

knob several turns in a clockwise direction.  While supporting the movable portion of the 

apparatus with one hand, use the other hand to pull the tilt knob out and then gently lower the 

entire 470A head to its down position.  If, as you lower the head, you see the glass cover slip 

distort or move then the periscope is hitting the cover slip.  Stop lowering the head, turn the 

vertical adjustment screw several more turns in a clockwise direction and then slowly lower the 

head again.   

4. During operation the bottom of the periscope should be betweeb 150µm and 200µm above the 

coverslip, the ideal height is 180µm.  Follow the procedure below to set the height of the 

periscope above the bottom of the bath. 

a) Mount the 340A Piezo Length Controller in the motor mount. 

b) Use the 820A controller and the 821A XYZ stages to position the needle mounted to the 340A 

Piezo Length Controller at the bottom of the bath.  Focus on the tip of the needle and 

gradually lower it, using the 821A stage, refocusing as required, until you see the tip move 

horizontally.  This will occur when the tip comes into contact with the cover slip.  Raise the tip 

back up until the horizontal movement stops.  The tip is now located at the cover slip surface.   
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c) Zero the XYZ readouts in the 820A software and then use the 820A to move 340A motor and 

the tip of the needle 180µm vertically upwards. 

d) Re-focus the microscope on the probe tip.  Your microscope is now focused 180µm above the 

cover slip.  Press the Retract button on the 820A software to get the micro tools away from 

the periscope.   

e) The vertical height of the periscope in the bath is adjusted using the miniature differential 

adjuster located at the back of the microscope mount assembly above the tilt knob.  This 

adjuster has a coarse and fine control.  The vertical coarse adjustment is controlled by the 

rotating the black knob.  Clockwise rotation will raise the periscope in the bath, 

counterclockwise rotation will lower it.  The adjustment of the black knob will change the 

periscope height by 825µm for every revolution of the adjuster black knob.  The adjuster also 

has a fine adjustment control that moves 65µm per revolution of the Allen screw located 

inside the centre of the black knob.  Insert a 1/16” Allen key into the top of the adjuster and 

then rotate the Allen key to fine adjust the height.  Note that the fine adjustment range is 

only +/-450µm.   If you run out of usable range on the fine adjuster then centre the fine 

adjustment Allen screw, use the coarse adjuster to get the height close to the desired height 

and then use the fine adjuster again to obtain the final position.  Turn the vertical adjustment 

knob counterclockwise to lower the head assembly (and the periscope) until the bottom of 

the periscope comes into focus.  Due to the very limited depth of field of the objective you 

can now be confident that the bottom of the periscope is about 180µm above the cover slip. 

f) Once the height is set, tighten the brass lock-nut located on the height adjustment screw. If 

when you tighten the lock-nut the periscope goes out of focus then fine adjust its height 

using the 1/16” Allen key.  The lock-nut only locks the coarse adjuster, not the fine adjuster.   

2.1.5 Attach the AFM Cantilever Assembly  

The AFM cantilever is the key element that provides force measurement.  When the muscle tissue 

contracts the AFM cantilever bends, this deflection is measured using the reflected laser light.  The 

circuitry in the head measures this optical deflection thus providing force measurement.  The AFM 

cantilever must be attached to the AFM holder and then precisely positioned with respect to the 

periscope.  The AFM holder mounts on the right XYZ stage using the rotatable probe clamp provided.  

Use the following procedure to mount the AFM holder. 

1. Attach an AFM cantilever to the AFM Holder using the procedure found in section 4.1.3. 

2. Loosen the rotation control knob on the side of the right probe clamp and rotate the clamp so 

that the mounting surface is horizontal.  Lightly tighten the knob so that the clamp doesn’t rotate 

unexpectedly.  

3. Loosen the clamp knob enough to insert the AFM Holder motor into the rotatable probe clamp.  

The holder can only be inserted from the left side of the clamp.  Note: if the AFM cantilever will 

hit the 470A periscope then use the right XYZ stages to move the AFM Holder to a safe location 

before inserting the holder.  

4. The AFM Holder has a flat on one face, ensure you orient it so that the flat faces towards the 

front of the microscope.  Tighten the clamp knob enough to hold the AFM Holder without any 

movement.   
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5. Loosen the rotation knob and rotate the clamp so that the AFM cantilever goes into the bath.  

Take care to orient the AFM cantilever so that it is vertical and then tighten the rotation knob.  

Take care not to rotate the clamp so much as to cause the AFM cantilever to strike the bottom of 

the bath.   

6. If required loosen the clamp knob again and slide the AFM Holder back and forth in the clamp 

until the cantilever tip is the correct amount into the bath.  Note: the XYZ stages control the fine 

position of the cantilever within the bath.  You only need to get the cantilever located close 

enough to the working location to then use the XYZ positioners.  You do not need to use the 

rotatable probe clamp to obtain the final position of the cantilever. 

7. The AFM clamp includes a fine angular position screw on the side of the clamp.  Center the fine 

adjustment screw in its range of movement which should orient the AFM cantilever to be parallel 

to the front face of the periscope.   

8. This completes the mounting procedure.  In section 2.5 there is a procedure for aligning the 

cantilever before use.  

2.1.6 Set up the Perfusion System  

The perfusion system is used to provide chemical actuation of the myofibril. The normal equipment 

configuration uses a double-barreled pipette (theta tubing – supplied in the accessory kit) to deliver 

either a relax solution or an activate solution to the myofibril.  The activate side of the double-barrel 

pipette is connected to a fluid handling system that allows multiple different pCa solutions to be 

connected to the pipette via a valve manifold.  This allows different pCa solutions to be delivered to 

the fiber as needed. The 470A was designed to work with the valve system and perfusion motor from 

a Warner VC-77CSP Perfusion Fast-Step system.  The 470A controller replaces both the VC-6 valve 

controller and the SF-77C Perfusion Fast-Step controller.  Only the fluid handling components and the 

motor are retained from the Warner system.   

Follow the instructions provided with the Warner VC-77CSP system for setting up the fluid handling 

system, valves, manifolds and the perfusion stepper motor.  If the Warner stepper motor was 

included with your system then it will plug directly into the DB-9 connector on the back of the 470A 

controller.  If you are using your own Warner system then obtain an adapter cable from ASI and plug 

the Warner motor connector into the adapter cable and then the adapter cable into the DB-9 

connector on the back panel of the 470A.  The back-panel DB-9 connector is labelled “To Solution 

Switcher”.   

The Warner valve module plugs directly into the back-panel DB-15 connector labelled “To Valve 

Controller”.  The 470A provides superior specifications for the control of the valves and the perfusion 

motor compared with the Warner control units.  In addition, the 600A software interfaces with the 

470A controller and allows software control of the valves and the perfusion motor thus providing 

automation via 600A test protocols and sequences. 

Refer to Section 4.1.4 for instructions on making the double-barrel pipette.  

2.1.7 Connect the AFM Head to the Controller 

At this point all subassemblies are mounted and now the AFM head needs to be connected to the 

control electronics. 
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1. Tilt the 470A head to the up position by pulling out the tilt knob, lifting the 470A and releasing 

the tilt knob to lock it into one of the raised positions. 

2. Position the 470A controller a maximum of 1m from the head in a clean, dry location.  A shelf or 

table located behind or beside the microscope works well for this.  As an alternative simply place 

the 470A on the vibration isolation table next to the microscope.  

3. Ensure the controller power switch is in the off position. Using the power cord provided, plug the 

cord into the back of the controller and into an appropriate AC power outlet.  We recommend 

obtaining a power bar and then plugging the 470A controller, the 340A controller and the PC into 

the same power bar.  Since these instruments share a common signal ground it is important that 

they all be plugged into the same AC circuit.  This is best achieved by plugging them all into the 

same power bar.   

4. Carefully remove the protective plastic cover from the end of the fiber optic cable coming from 

the front panel of the 470A controller.  This fiber optic cable is internally connected to the laser 

that is housed within the controller.  Plug the fiber optic cable into the collimator located on the 

left side of the 470A head.  Note that there is a raised key on the fibre connector and a matching 

slot on the collimator body. Ensure that you properly align the connector before tightening the 

clamp ring.  Failure to align the cable properly with the connector will result in poor signal quality 

from the 470A.   

5. Attach the 8-pin miniDIN cable to the front panel of the controller and to the back-left side of the 

470A head.  Ensure the cable is fully seated at both ends. 

6. Attach the DB-9 motor cable from the head to the front panel connector labelled HEAD. 

7. Using three BNC-BNC cables attach the output signals from the front panel of the controller to 

the 604A signal interface as follows:  Connect N to Force In (A/D 2) on 604A, connect L to Aux 1 

(A/D 3) on 604A, connect S to Aux 2 (A/D 4) on 604A, see Table 2. 

8. Using one of the supplied Ethernet cables, attach the LAN connector on the front panel of the 

470A controller to a LAN port on the router supplied with the system.  Do not attach the cable to 

the WAN/Internet port on the router and also do not connect it directly to a lab Ethernet 

connector.  For proper operation, all Aurora Scientific Ethernet-based devices should be plugged 

into the supplied router.  Note: you are welcome to attach this router to your lab Ethernet 

network if your IT policy allows this.  If you make this connection then you will have an internet 

connection available on the 600A PC. 

9. Turn on the power switch on the front panel of the 470A controller.   After power on checks the 

Power LED will light.  The 470A is now ready for connection to the 600A software.   

 

2.2 Starting the 600A Control Software  

The 470A AFM force transducer was designed to be controlled using Aurora Scientific 600A control 

software.  This software will control all aspects of the experiment and collect data during each test.  The 

software also provides simple analysis of collected data.  Please refer to the 600A Instruction Manual for 

complete information about the setup and use of the 600A software.  Only simple connection 

information and program startup information is provided here.     



Myofibril AFM Force Transducer Instruction Manual 
Model: 470A 

© Aurora Scientific, 2019-2021                                        VER. 1.4 page 18 

 

2.2.1 600A Data Acquisition System Setup 

The 600A data acquisition system consists of a the 600A control software, tower PC, keyboard, 

mouse, data acquisition card, signal interface, BNC cables, and BNC terminators.  Also included with 

your order should be two monitors.  The 600A PC should be located within 2m of the microscope so 

that all connections to the equipment can be made without difficulty.  Follow the normal instructions 

for setting up a PC, place it in a clean dry place and organize the peripherals for ease of conducting 

the experiment.  During an experiment the researcher will need to access both the microscope and 

the PC.  For this reason, we suggest you mount the PC on a table adjacent to the microscope.  

1. Attach the monitors, keyboard and mouse to the back of the PC.   

2. Install the A/D card into a slot within the PC. 

3. Connect the cable from the 604A Signal Interface to the A/D card. 

4. Using one of the supplied Ethernet cables, attach the LAN connector on the back of the PC to a 

LAN port on the router.  Do not attach this cable to the WAN/Internet port. 

5. If you want the 600A PC to be on your laboratory network, then plug the WAN/Internet port on 

the router into your lab network.  It is best to check with your local IT department before 

connecting the router to a local network.  

6. Plug the PC power cable into the same power bar that you have plugged the 340A and 470A 

controllers into.   

7. Make the connections shown in Table 2 between the 604A Signal Interface and the equipment 

using the BNC cables provided.  Attach the supplied 50-ohm terminators to the unused Aux input 

channels labelled Aux 3-Aux 6 (A/D 5 – A/D 8).   Do not put terminators on the D/A outputs or any 

of the I/O connections. 

 

604A Signal Interface 

Connection 

340A Controller 470A Controller 

A/D 1 (Length In) Length Out  

A/D 2 (Force In)  N 

A/D 3 (Aux 1)  L 

A/D 4 (Aux 2)  S 

D/A 1 (Length Out) Length In  

Table 2 Connections between 604A/E and Equipment 

 

2.2.2 600A Software Startup 

The 600A data acquisition and control software comes pre-installed on the PC.   

1. Turn on the PC and wait for it to boot up. 

2. Click on the 600A icon on the desktop to start the program.  If the program indicates that the 

software isn’t licensed then do that now.  Once licensed the software will operate properly.  



Myofibril AFM Force Transducer Instruction Manual 
Model: 470A 

© Aurora Scientific, 2019-2021                                        VER. 1.4 page 19 

 

3. Click on the Calibrate menu and then click on Models Attached.  Under the Lever System heading, 

select 340A and under Force Transducer heading, click on 470A.  In the Aux section set the name 

for Aux 1 to L (or Lateral) with the units set to V (or Volts) and the Scale (gain) set to 1.0 and 

Offset (zero) set to 0.0.  Likewise, set the name for Aux 2 to S (or SUM), units to V, Scale to 1.0 

and Offset to 0.0.  Click OK to close the Models Attached window. 

4. As soon as you close the Models Attached window the 600A software will try to connect to the 

470A controller via the Ethernet connection.  In most cases the connection will be automatic and 

the 470A Status window will open and show that you are connected, see Figure 4. 

5. If the 470A does not connect automatically then click on the Device menu item and then click on 

Connect to Device.  The 470A device should then be found, click on the device in the list shown in 

Figure 5.  

Figure 4 470A Status Window 
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6. Click on the Calibrate menu and then click on Force.  This will open the 470A calibration window 

which is used during optical alignment and for calibrating the 470A. 

 

2.3 Starting the HVSL Sarcomere Length Software  

The 470A AFM force transducer was designed to be used with an Aurora Scientific 901D High Speed 

Video Sarcomere Length (HVSL) system.  The HVSL sarcomere length hardware and software is used to 

monitor sarcomere length of the myofibril during an experiment.  The software is also used to observe 

the experiment and to calibrate the 340A High Speed Length Controller.  Please refer to the 901D 

Instruction Manual for complete information about the setup and use of the 901D system.  Only simple 

connection information and program startup information is provided here.     

2.3.1 Camera Setup 

The 901D consists of a camera, connection cable and the software which is pre-installed on the 600A PC.  

The camera should be attached to a camera port of the microscope using a 0.5X C-mount adapter 

(adapter is not included with the system).   

1. Screw the camera to the 0.5X C-mount adapter. 

2. Attach the adapter to the camera port of the microscope. 

3. Make sure the PC is off and then plug the USB 3.0 cable into the camera and then into a USB 3.0 

port (blue USB connector) on the back of the 600A PC, do not use a front panel USB connector.  

The camera is powered through the USB connection and there are no other connections required 

between the camera and the PC. 

4. Follow the procedure below to start the software.   

2.3.2 901D HVSL Software Startup 

The 901D software comes pre-installed on the 600A PC.   

1. Turn on the PC and wait for it to boot up. 

Figure 5 Connect to Device Window 
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2. Click on the 901D icon on the desktop to start the program.  If the program has not been licensed 

then it will not start.  In this case license the software following the procedure outlined in the 

901D manual and then start the program.  

3. After a few seconds the camera image will be shown in the program window.  

4. Observe the orientation of the image and rotate the camera so that a myofibril would appear 

horizontal on the screen.  The best method of rotating the camera is to loosen the screws holding 

the port adapter into the microscope.  Rotate the port adapter and then, when correctly aligned, 

re-tighten the screws.  Note: HVSL calculates the horizontal distance between sarcomeres.  For 

this reason, the fiber must be aligned on the screen in a horizontal direction. 

5. Due to the orientation of the myofibril in the experiment it may be advantageous to have the 

HVSL image on the screen match the image you see through the microscope eyepieces.  To do 

this click on the Camera Rotation menu item and then click on the 90° rotation button.  Once the 

image rotates you may also need to mirror the image in one or both of the X and Y planes.  To 

check if the HVSL image matches the microscope image observe movement of one of the probes 

in the microscope.  Then check the HVSL image to see if the probe is moving in the same 

direction on the screen.  If not, then change the appropriate mirror button.   

6. Calibrate the Lo and Hi resolution objectives you intend to use with the experiment, these will 

normally be a 4X and a 60X objective when studying myofibrils.  Follow the calibration procedure 

presented in the 901D Instruction Manual.   

 

2.4 Starting the 820A Motion Controller Software  

Left and right XYZ motorized stages (model 821A) are used to position the two probes used with the 470A 

AFM force transducer (piezo motor and AFM cantilever).  These stages are controlled using an Aurora 

Scientific 820A XYZ Motion Controller and the 820A software program provided on the 600A PC.  The 

820A software controls the position of each probe to within 1µm.  It also provides a digital readout of the 

position of each probe and waypoints that allow you to remember probe locations and then easily return 

to these locations.  Another major feature of the 820A Motion controller is that it provides slaved motion, 

this means that once a myofibril is attached to the two probes, the probes can be moved in unison to any 

desired location.  Please refer to the 820A Instruction Manual for complete information about the setup 

and use of the 820A XYZ Motion Controller and its software.  Only simple connection information and 

program startup information is provided here.     

2.4.1 Connecting the 821A XYZ Stages to the 820A Controller 

1. Place the 820A controller in a convenient location within 2m of the microscope, note there are 

no front panel controls on the 820A so you do not need easy access to the 820A after you have 

made all of the connections to the 821A. 

2. Plug the DB-25 connectors from the left XYZ stages into the mating connectors labelled Left on 

the front panel of the 820A controller.  Ensure that the X, Y and Z stages are plugged in correctly 

to the connectors labelled X, Y and Z.  For the purposes of this manual the X direction is in the 

direction of the long axis of the myofibril which is also the front to back axis of the microscope.  

The positive X direction will move the probes towards the periscope (i.e., towards the condenser 
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pillar, i.e., away from the operator). The Y axis is the side to side direction or across the 

microscope with the positive Y direction moving the probes to the right.  The Z direction is the 

vertical direction with positive Z moving the probes vertically upwards.   

3. Using one of the supplied Ethernet cables, attach the LAN connector on the front panel of the 

820A controller to a LAN port on the supplied router.  Do not attach the cable to the 

WAN/Internet port. 

4. Plug the left push-button controller into the DB-15 connector labelled Left.  Likewise, plug the 

right push-button controller into the connector labelled Right.  If you are using Joystick 

controllers, then plug the supplied Joystick adapter cables into the front panel of the 820A 

Controller and then each appropriate joystick into the matching adapter cable.  

5. Plug the power cord into the back of the controller and into an appropriate AC socket. 

6. Turn on the 820A Motion Controller using the front panel Power switch. 

2.4.2 820A Motion Controller Software Startup 

The 820A software comes pre-installed on the 600A PC.   

1. Turn on the PC and wait for it to boot up. 

2. Click on the 820A icon on the desktop to start the program. 

3. The software will connect with the controller and then display the main screen.  

4. Before using the 820A you must Home the stages and Calibrate them.  Since the stages will move 

through their entire range of motion, we recommend that you either orient the probes in a safe 

manner to prevent breakage during the Home and Calibrate procedures or remove the probes 

from the holders. Refer to the 820A Instruction Manual for complete information on the Home 

and Calibrate functions.   

5. When the program starts it should automatically ask you to Home the stages.  If not, then click on 

Move -> Home. 

6. To Calibrate the stages, click on Settings -> Configure Instrument.  When the window opens click 

on the Calibrate button on the left side of the screen and then click on the Calibrate Space button 

near the bottom of the window.  Do not use the program motion controls until you have properly 

calibrated the stages.   

7. The 820A program remembers Waypoints when you close the program.  This means that you can 

set Waypoints and then come back to them on a different day.  Be careful about using stored 

Waypoints as they will not be accurate if you have adjusted the probes in the mounts.   

 

2.5 Optical Alignment  

2.5.1 Placement of the Laser Beam 

The location of the laser beam exiting the 470A head can be adjusted using two procedures. The first 

procedure requires adjusting the periscope orientation and position to better guide the laser beam to the 

correct location.  The second involves fine adjustment of the laser beam location as it exits the periscope 

using the internal mirrors.  
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2.5.2 Adjustment of the 470A Periscope 

The desired location for the periscope exit face is about 500µm behind the optical axis of the microscope 

(towards the back of the microscope) and approximately 180µm above the coverslip.  However, this 

location is dependent on the microscope and the alignment of the periscope.   

Setting the location of the periscope can be done using the procedure listed below. 

1. The coarse location of the 470A Head can be adjusted when clamping the microscope mount to 

the microscope.  Loosen the two M5 socket head cap screws slightly and reposition the head, 

then re-tighten the screws. 

2. The fine location of the 470A Head can be adjusted using the fine adjustment screws located on 

the front face of the microscope mounting plate (the plate that the 470A head is attached to).  To 

fine adjust the location of the head, first loosen the clamp screws located on either side of the 

head.  Next turn the left and right fine adjustment screws to move the entire head with respect 

to the mounting plate.  Note these screws are intended to allow the location of the head to be 

positioned in the X direction with respect to the optical axis of the microscope.  These screws also 

allow a very small amount of rotational adjustment of the head to be made by screwing one of 

the fine adjustment screws more than the other.  Gross changes to the angle of the head should 

be done using the M5 screws that hold the entire apparatus to the microscope. 

3. The vertical height of the periscope is best adjusted using the differential coarse-fine adjustment 

screw located on the back, right side of the microscope mount.  Use the procedure in section 

2.1.3 to adjust the height.   

4. The periscope is attached to the periscope holder which is, in turn, attached to the front on the 

470A head.  The position and angle of the periscope holder can be adjusted using a 2mm Allen 

key.  There are three holes in the front of the holder.  If all screws are moved an equal amount, 

then the periscope holder will move in or out from the 470A head depending on the direction of 

rotation of the screws.  Rotating the screws clockwise will move the holder away from the head, 

rotating them counterclockwise will move the holder closer to the head.  The screw on the right 

side rotates the periscope holder around the Z axis (tips the periscope side to side).  The two 

screws on the left rotate the periscope around the Y axis (tip the periscope up or down).  The 

periscope holder is attached to the head by magnets.  By grasping the holder and pulling away 

from the head the entire periscope holder, along with the periscope, can be removed from the 

head.  This is useful when cleaning the periscope or when you need to get clear access to the 

bath.   

5. The periscope clamps into the periscope holder via a nylon tipped set screw.  Use a 2mm Allen 

key to loosen the set screw on the left side of the periscope holder and then re-tighten the screw 

after the new location of the periscope is set.  This adjustment should normally be avoided as 

touching the periscope surface is not recommended. 

2.5.3 Fine Adjustment of the Laser Beam Position   

The laser beam location as it exits the periscope can be adjusted by turning the two fine adjustment 

knobs on the right side of the 470A Head.  These knobs move the laser beam vertically and horizontal,  

refer to Figure 3.  If the laser controller is turned on during adjustment, the laser beam displacement can 
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be seen on the surface of the periscope.  Ideally, the laser beam should be placed at the center of the 

periscope and at the lowest position possible before the laser beam hits the edge of the periscope.   

 

2.6 Setting up the AFM Cantilever  

Integrating an AFM cantilever into the 470A system is critical to correct function.  The cantilever serves as 

one of the micro-tools that will manipulate the fibers being studied as well as a fundamental part in any 

signal obtained by the system.  Three procedures are necessary to integrate a cantilever to this system. 

The first involves assembling a cantilever to its holder which then attaches to the right micro-

manipulator.  The second involves aligning the cantilever to the laser beam.  The third involves knowing 

the stiffness of the cantilever. 

2.6.1 Attaching the AFM Cantilever to the AFM Holder 

A cantilever must be attached to the AFM Holder and integrated onto the micro-manipulators associated 

with the system.  This is done during the initial setup of the system and whenever the cantilever breaks or 

loses its reflectivity due to overuse.  Mounting the AFM Cantilever on the AFM Holder is a process that 

requires some care.  Follow the procedure in section 4.1.3 to attach a new AFM cantilever to the AFM 

Holder. 

2.6.2 Verifying Alignment of the Laser Beam 

Verify correct alignment of the laser beam prior to aligning the AFM Cantilever to the laser beam using 

the following procedure.   

1. Make sure that the periscope has been placed in the correct location as described in section 

2.5.2. 

2. Turn on the microscope illumination. 

3. Turn on the 820A XYZ Motion Controller. 

4. Turn on the 470A controller. 

5. Start the 600A software and use the 470A control window to turn on the laser.  

6. Make sure that the laser beam is exiting the periscope at a desired location as described in 

section 2.5.3. 

7. Verify that the periscope shines a single laser spot with the focal point outside the periscope.  

8. Tilt the 470A Head upwards and lock in place using the Tilt knob.  

9. Monitor the spatial intensity distribution of the laser beam by placing a piece of paper 

somewhere in the path of the laser beam, far from the periscope.  Bring the paper closer to the 

periscope.  The laser spot will keep getting smaller until it reaches its minimum diameter after 

which it will increase in size again.  This is shown in Figure 6. 
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10. If the laser beam has more than one spot or the focal point of the laser beam is too far inside or 

outside of the periscope then the periscope or the laser beam are misaligned and the procedure 

in section 2.5 must be performed.  Moreover, if the laser beam has some obstructions then this 

obstruction is a result of something on the periscope.  This can be fixed by wiping the periscope, 

but extreme care must be taken.  If the periscope is to be cleaned, it should only be wiped with 

water and a clean optical wipe.  Please review the cleaning information in section 4.1.2 before 

cleaning is started. 

11. At this point you will have verified that the laser beam is exiting the periscope correctly and that 

you have a well-defined focal point. 

2.6.3 Aligning the AFM Cantilever to the Periscope 

The AFM Cantilever must be aligned so that it is vertical and parallel to the exit face of the periscope.  If 

not, the laser beam will not reflect off the cantilever and back into the 470A Head.  The purpose is to 

place the reflective face of the cantilever perpendicular to the laser beam (parallel to the exit face of the 

periscope).  This procedure is best performed in air.  

1. Remove the bath from the microscope stage and then tilt the 470A Head to its down position. 

This will allow you to visualize both the cantilever and the periscope.  Set the microscope to low 

magnification (4X is appropriate).   

2. Look through the microscope and focus on the lower edge of the Periscope 

3. Use the 820A XYZ Motion Controller to bring the tip of the cantilever in focus with the lower edge 

of the periscope.  

4. If the cantilever is not parallel to the exit face of the periscope you must use the fine adjustment 

screw on the side of the AFM clamp to rotate the AFM cantilever until the cantilever is parallel to 

the periscope exit surface.  You can use the HVSL program to view the periscope and the 

cantilever and draw a region of interest on the software window as a measure of how parallel the 

periscope exit face and the cantilever face are to each other.  

5. If required loosen the clamp knob again and slide the AFM Holder back and forth in the clamp 

until the cantilever tip is roughly centered on the periscope exit face.  Note: the XYZ stages 

control the fine position of the cantilever within the bath.  You only need to get the cantilever 

located close enough to the working location to then use the XYZ positioners.  The positioners 

have +/-10mm of movement in all directions so you do not need to use the rotatable probe 

clamp to obtain the final position of the cantilever. 

Focal Point 

Periscope  

Laser beam  

Figure 6 Top View of Periscope and Laser Beam showing Focal Point of Beam 
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6. If you adjusted the position of the AFM Holder, then you will need to change the XY and Z 

positions to bring the cantilever tip back into focus with the lower edge of the periscope.  

2.6.4 Aligning the AFM Cantilever to the Laser Beam 

The AFM Cantilever must be aligned to the laser beam to ensure that the laser beam, when reflected off 

the cantilever, goes back into the quadrant detector inside the 470A Head.  The purpose is to place the 

cantilever as best as possible in the focal region of the laser beam.  This procedure is best performed in 

air.  

1. Use the 820A XYZ Motion controller to place the cantilever in front of the laser beam and monitor 

the projection of the laser beam on a piece of paper placed behind the cantilever.  By placing a 

piece of paper somewhere in the path of the laser beam, far from the periscope, the spatial 

intensity distribution of the laser beam can be monitored. 

2. Move the cantilever along the path of the laser beam. It will block the light on the piece of paper 

as it gets closer to the focal region. Far away from the focal region the obstruction will only be 

partial as shown in Figure 6c.  

 

Figure 6 illustrates the technique to align the cantilever at the focal point of the laser beam. (a) shows the laser 
beam uninterrupted with the focal point in front of the periscope. (b) shows the ideal location for the cantilever at 

the focal point of the laser beam. (c) shows the cantilever placed too far from the periscope and (d) shows the 
cantilever placed too close to the periscope 

 

Focal Point 

Periscope  

Laser beam  

(a) 

Cantilever 
(b) 

(c) 

(d) 

Figure 7 Top View of Periscope, Laser Beam and Cantilever 
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Keep moving the cantilever towards the periscope while keeping its shadow in the center of the 

laser spot until the cantilever completely blocks the laser beam projected on the paper.  Place the 

cantilever at the focal region of the laser beam. This region is situated where the laser beam size 

is the smallest. To find this region continue to move the cantilever towards the periscope.  Verify 

from time to time the laser beam width by moving the cantilever along the Y axis (across the laser 

beam).  By recording the distance that the cantilever is moved from the point where one side of 

the cantilever starts to cover the laser beam until the point on the other side where the laser 

beam is uncovered, the laser beam width can be monitored.   Note: to determine the Laser Spot 

Size you will need to subtract the width of the cantilever from the recorded distance.  If you are 

just using the cantilever beam itself then subtract the beam width (normally 50µm).  If you have 

lowered the cantilever so that the whole cantilever mounting chip is covering the laser beam, 

then subtract the mounting chip width (normally 1.6mm).  See Figure 8 for an illustration of this.  

A simple way to measure the laser beam width is to monitor the Sum signal using 600A.  You can 

monitor the Sum signal either using the Calibrate->Force function or the Scope function.  When 

the cantilever is centered on the laser beam the Sum signal will be at a maximum and will drop 

for movement of the cantilever in either the + or – Y direction. 

3. After the cantilever is situated at the focal region, lower the cantilever such that the laser beam 

hits the support chip holding the cantilever.  This provides a large enough reflecting surface to 

ensure signal is received by the 470A Head during further alignment steps. 

 

 

2.6.5 Final Alignment in Water 

The rest of the alignment is done in water since the refractive index in air and in water are different and 

this difference affects the alignment.    

1. Inspect the bath and clean it if required.  Also inspect the cover slip on the bottom of the bath 

and replace it if it is cracked or dirty.  Use the procedure in section 4.1.1 to replace the cover slip.  

2. Tilt the 470A Head up and lock it in place using the Tilt knob.  Place the bath on the microscope 

stage in the large stage cutout (if necessary, remove any stage insert prior to putting the bath in 

place).  

3. Tilt the 470A Head down into the bath and then fill the bath with water.  

4. Turn on the 340A Controller, the 470A Controller, the 820A Controller and the 600A PC.  Start the 

HVSL software and the 820A software.  Start the 600A software using the procedure is section 

2.2.  Ensure you are on the Calibrate>Force window labelled ASI470A Calibration Window. 

Cantilever Width   

 
Laser Spot Size 

Recorded 
Movement 

Laser Spot Size  
= Recorded Movement – Cantilever Width  

Figure 8 Determining the Laser Spot Size 
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5. Three signals will be displayed on the graph:  N, L and S.  These signals are: N for Normal which is 

the signal that results when the cantilever is bent in the force measuring direction (this is also the 

Force In signal), L for Lateral which is the signal that results from the cantilever twisting or when 

the cantilever is not parallel to the exit face of the periscope, and S for Sum which is the total 

light signal incident on the 4-quadrant photo detector that is built into the 470A Head.  Note: a 

very low or zero level Sum signal indicates that the laser beam is not incident on the photo 

detector. 

6. On the ASI470A Status Window in the Detector Motor Status and Control section of the window 

press the Home button to set the starting position of the quadrant detector motor.  Then enter 

5.000 mm in the Move to Position (mm) data entry box and press the Move button.  This will set 

the quadrant detector motor to its centered position (center of its 0-10mm range of motion).  

7. The objective of this step is to maximize the S signal while minimizing both the N and L signals.  

This is done by first moving the cantilever using the 820A XYZ Motion Controller, then rotating 

the cantilever by using the fine adjustment rotation built into the AFM Holder and then further 

XYZ movements using the 820A.  What you are doing is trying to place the reflected laser beam as 

close to the centre of the quadrant detector as possible. This is done using the following process. 

a. Make fine adjustments of the rotational and lateral angle of the cantilever with the 

micro-manipulator structure while monitoring the N, L, and S signals.  

b. Typically, when the cantilever is being aligned it is important to obtain a maximum value 

for the S signal (which means that the laser beam is entirely somewhere on the detector), 

and to have the N signal as close as possible to zero.  Ideally the L signal should also be as 

close as possible to 0, but this ideal situation is very hard to achieve.  Also note that if the 

S signal goes to zero the beam is not reaching the detector. 

c. A positive N signal means that the laser beam is reflecting on the top part of the 

quadrant detector and the cantilever must be rotated downwards to get the N signal 

closer to zero.  

d. The lateral and rotational adjustments are coupled, which makes the alignment more 

tedious.  To get the cantilever perfectly parallel in front of the periscope all the degrees 

of freedom of the cantilever must be adjusted.  The translational degrees of freedom can 

be controlled using 820A XYZ Motion Controller and these adjustments are straight 

forward and are not an issue during an experiment.  The rotational degrees of freedom 

are more difficult to adjust as these are adjusted manually and they must be kept fixed at 

the correct orientation once the alignment is complete. 

e. Iterate small changes of the lateral and rotational angle.  As you rotate the cantilever 

make sure to bring it back to the location where the laser beam is hitting the support 

chip if the rotations cause the overall position of the cantilever to change. 

f. When the optimal situation is reached, place the cantilever, not the chip, in the path of 

the laser beam and make sure that the alignment is still valid.  This is done by raising the 

AFM Holder, move the AFM Holder upwards in the Z direction.  

g. Once aligned you need to verify that the cantilever is functioning properly by performing 

the procedures listed in section 3.3. 
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2.6.6 Cantilever Stiffness 

The cantilever stiffness (sometimes referred to as the Force Constant) is an important parameter that is 

used to convert the cantilever deflection, measured by the N signal, to Force units.  This quantity typically 

varies for each cantilever used with the system.  To obtain the stiffness the user must use the information 

provided by the AFM cantilever manufacturer or attempt to determine this value experimentally.   

The manufacturer’s nominal stiffness value for the cantilevers shipped with the instrument is given as 

0.2N/m but this has a published range from 0.07 – 0.4N/m.  If your experiment presents the force data as 

relative Force (Actual Force / Peak Force) then the actual stiffness value is not important as it cancels out 

when you calculate the ratio.  However, if you want to measure true forces, then you must have an 

accurate stiffness value for the cantilever.  There are numerous methods presented in the literature for 

calculating the stiffness of AFM cantilevers.  Of these the simplest method depends on measuring the 

dimensions of the beam and then calculating stiffness by assuming a known Young’s modulus using the 

following equation for a rectangular cantilever with a rectangular cross section 

 

k = Ewt3 /4l3 

 

where k is the spring constant (Force Constant), E is the Young’s modulus of the beam, and w, l, and t are 

the beam width, length, and thickness, respectively.  For the AFM cantilevers supplied with the 470A, the 

manufacturer’s dimensions are provided in Table 3 below. 

 

Parameter Nominal Value Range 

Force Constant (k) [N/m] 0.2  0.07 - 0.4 

Resonant Frequency [kHz] 13 9 - 17 

Length (l) [µm] 450 440 – 460 

Top Width (wt) [µm] 50 45 – 55 

Bottom Width (wb) [µm] (trapezoidal) 27 22 – 32 

Thickness (t) [µm] 2 1 - 3 

Young’s Modulus (E) [N/m2] 169x109 130.2 – 187.5 

Density (ρ) [kg/m3] 2330  

Material Silicon  

Table 3 Manufacturer Data for AFM Cantilevers Supplied with 470A 

 

Using the nominal values listed in the table, k is calculated as 0.185 N/m which is slightly lower than the 

manufacturer’s provided Force Constant of 0.2 N/m.  Using the minimum values for l, w and t, the Force 

Constant is calculated as 0.02 N/m.  Whereas using the maximum values shown results in a k of 0.645 

N/m.  Notice that the values calculated by using all minimum or all maximum values exceeds the 

manufacturer’s stated k range of 0.07-0.4 N/m.  This serves to illustrate just how dependent k is on the 
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physical dimensions of the cantilever.  If you can accurately measure the dimensions of the cantilever, 

then you will be able to obtain a more accurate value of k than if you simply use the nominal value 

provided by the manufacturer.  Note: during calibration of the system the software is able to provide you 

with this calculation automatically.  The software can calculate the stiffness for either a uniform 

rectangular beam or for a trapezoidal beam profile (typical trapezoidal widths are in Table 3.  Most AFM 

beams have a trapezoidal profile.  If you are able to measure the dimensions of the cantilever then you 

can enter these dimensions into the program and it will calculate the stiffness for you.   
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3 General Operating Procedure 

This chapter provides a procedure that can be used to conduct myofibril experiments with the 470A 

system.  

3.1 Preparing the Software Packages 

The 470A system uses three programs: 600A for data collection and analysis, 820A for XYZ motion control 

and 901D for camera control and SL measurement.  Within the 600A software is a module that provides 

470A control and a module that controls the solution valves and the fast-stepping perfusion motor.    

1. Turn on the 470A controller, the 340A controller and the 820A controller. 

2. Click on the 600A icon to start the program. 

3. When the 600A software starts it should automatically connect to the 470A controller.  If it 

doesn’t then click on Calibrate>Models Attached and ensure that the 470A Force Transducer 

and the 340A Length controller are selected.  Setup the Aux 1 and Aux 2 channels to be Lateral 

(V) and Sum (V) if they are not already set. On the 470A Status window, Figure 4, click on 

Connect and select your 470A instrument. 

4. Open the Setup window and set Lo to a valid length (if you don’t know the myofibril length at 

this point then enter 0.050 mm (50µm), then click on Record Lin and Record Fin. Close the 

Setup window. 

5. Click on Calibrate>Force to open the 470A calibration window.  

6. On the 470A Status window click on the Home button to home the quadrant detector motor.  

This initializes the motor that drives the quadrant detector.  

7. The 470A Status window includes a gain control that can be set to 1x, 2x, 4x or 8x.  Once the 

gain is changed, it must be kept at the same value for the whole experiment to ensure valid 

results.  Increase the gain if the signal seen due to the displacement of the cantilever is very 

small. This can be tested by moving the cantilever with the piezo motor and observing the 

magnitude of the signal. Note that increasing the gain will amplify the noise as well as the 

signal.  Amplification over 10 volts will saturate the A/D converter and will not allow detecting 

a signal above that voltage. 

8. Click on the 820A icon to start the XYZ motion control program. 

9. Ensure the micro tools are clear of the 470A periscope and press the Home button to home 

the stages.   

10. Using the push button controllers, position XYZ stages to locate the tools in front of the 

periscope but at a slightly higher elevation than the bottom of the periscope.   

11. Click on the 901D icon to start the HVSL program and observe the camera image on the 

monitor. 

12. Select the Lo-Mag setting. 
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3.2 Preparing the 470A Apparatus 

1. Turn on the microscope illumination. 

2. The system has six micro-manipulators, three on each side of the microscope. The right micro-

manipulators are used to control the position of the AFM Cantilever and the left ones are used 

to control the position of 340A Piezo Motor and the glass needle.   

3. Change the objective on the microscope to low magnification (4X).   

4. Tilt the 470A up and lock it in one of its raised positions in order to provide clearance to place 

the bath in the stage. 

5. Place the bath onto the microscope stage in the 100mm round cutout or in the rectangular 

cutout.  Place the bath so that the cooling/heating inlet and outlet connections are on the 

same side as your temperature controller. The bath should be rotated to align it roughly 

parallel to the stage with the temperature control connections on one side and the bath 

suction outlet on the other. 

6. Connect a peristaltic suction pump inlet (or some other type of suction system) to the suction 

outlet on the bath. The outlet is 18GA hypodermic needle tubing that has an outside diameter 

of 1.27mm (0.050 inches).  1/16” OD Teflon tubing works well to connect the pump to the 

outlet tube.  This pump removes liquid from the bath as the experiment progresses. 

7. Place the pump outlet into a beaker to collect the liquid.  Discard any solution pumped out of 

the bath. 

8. Connect the bath to the temperature controller (supplied by the lab) so that fluid passes 

through the bath.  In most experiments you will want to cool the myofibril and therefore set 

the temperature controller to between 5-10 °C (it takes about 10 minutes to cool the bath to 

the operating temperature).  Note: the actual bath temperature will be greater than the 

setpoint temperature when cooling and less than the setpoint when heating.  This is due to 

temperature loss in the piping and in the bath.  Monitor the actual liquid temperature in the 

bath and adjust your temperature controller accordingly to achieve the desired operating 

temperature.  

9. Tilt the 470A apparatus down to its operating position.  Be very gentle to make sure that the 

micro-tools or periscope do not hit the bath and that the microscope table is centered at the 

periscope location. 

10. Move the objective to put the bottom edge of the periscope in focus.  Previously the periscope 

height was set to approximately 180 µm above the coverslip, see section 2.1.4.   Note: be very 

careful not to touch the coverslip when focusing objectives on the micro-tools.  If the objective 

contacts the bottom of the glass coverslip the whole bath could be raised, and this could result 

in breakage of the micro-tools. 

11. Verify that the periscope is in the position set in the previous experiment. This step is done to 

roughly make sure that nothing happened to the periscope that will have changed its location 

from one experiment to the next. 

12. Using the 470A Status window in the 600A software, turn on the laser.  Verify that a single 

laser spot with the focal point outside of the periscope is present.  Refer to section 2.5 for 

instructions on checking laser focus, if required. 
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13. Roughly align the 340A Piezo Motor glass needle into the center of the field of view. 

14. Use the left micro-manipulator to bring the needle close to the periscope.  Use the XYZ stage 

controls or the 820A software controls to bring the needle down and into focus. Note: If the 

needle touches the coverslip it will slide in the plane of the coverslip.  Stop lowering the needle 

if you see this occur.  

15. Roughly align the AFM Cantilever into the center of the field of view. 

16. Use the right micro-manipulator to bring the cantilever into the center of the field of view. Use 

the XYZ stage controls or the 820A software controls to bring the AFM Cantilever down and 

into focus. Note: The cantilever is very small, ensure you are focusing on the tip of the 

cantilever and not on the body of the cantilever chip.  If the cantilever touches the coverslip it 

will probably break, so be very careful and don’t lower the cantilever too much.   

17. Place some water in the bath. Add about 3 ml of water, however, if a meniscus forms add one 

extra ml and then pull it out again to get rid of the meniscus. 

18. Leave the bath for 10 minutes to allow air bubbles to settle.  If bubbles remain after 10 

minutes, then raise both the needle and cantilever. Tilt the 470A up and wait for 1 minute then 

lower it back into the bath. 

19. Focus on the periscope and move the cantilever and the needle into the field of view and fine 

adjust their X, Y and Z positions to bring them into focus. When the cantilever goes into the 

solution a large discoloration will occur as the cantilever support chip breaks the fluid surface. 

After the cantilever is fully immersed this discoloration will disappear.  

20. Wait for another minute to check that no more bubbles formed, if there are still bubbles, 

repeat the process. 

21. On the 470A Status window click on the Valves menu item to open the software Valve 

Controller window.  Make sure that all valves are off.  Press the Home button to home the fast-

stepping perfusion motor. 

3.3 Calibration of the 470A using the Calibrate>Force Window  

1. Change the magnification to 60x on the microscope. 

2. Move the 340A needle into view on the microscope.  Focus on the needle tip.  Slowly lower the 

needle and refocus as you lower it, until the needle touches the coverslip.  Move the needle 

down in increments of 1 or 2 µm when you get close to the coverslip.  When the needle 

touches you will see the needle move laterally across the field of view.  Now raise the needle 

until it moves back to its undeflected location.  This height corresponds to the surface of the 

coverslip.  Zero the needle XYZ actuators using the Zero function in the 820A software.   

3. Open Instrument Configuration>Limits on the 820A software and set the Z lower limit for the 

needle to the current location.  This action will cause the 820A software to prevent any Z 

movement of the needle below this height and therefore protect your equipment from 

damage.  

4. Move the needle up by 180 µm or by an amount determined by your desired elevation of the 

myofibril.  Note: this elevation also acts to set the sensitivity of the instrument because it will 
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set the point where the laser beam hits the cantilever, see Figure 9.  Focus the microscope on 

the needle tip.   

5. Using the XYZ stages, move the cantilever until it is in view on the microscope.  Raise or lower 

the cantilever until it comes into focus.  Place it on the far side of the needle so that the needle 

is between the periscope and the cantilever.   

6. Lower the cantilever to the coverslip until it touches the surface.  When you get close to the 

surface only adjust the elevation by 1 µm at a time so that you can observe the bending 

without breaking the cantilever.  It will be obvious when the cantilever bends.  

7. Now raise the cantilever until it moves laterally back to its undeflected location.  This height 

corresponds to the surface of the coverslip.  Zero the cantilever XYZ actuators using the Zero 

function in the 820A software.   

8. Open Instrument Configuration>Limits on the 820A software and set the Z lower limit for the 

cantilever to the current location.  This action will cause the 820A software to prevent any Z 

movement of the cantilever below this height and therefore protect your equipment from 

damage.  

9. Move the cantilever up by 180 µm or another amount according to the desired elevation of the 

myofibril.  Note: this elevation also acts to set the sensitivity of the instrument because it will 

set the point where the laser beam hits the cantilever, see Figure 9.  Note: The location of the 

cantilever from the surface is extremely critical.  Once a cantilever elevation from the surface  
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of the coverslip and the distance from the periscope (standoff distance) are chosen all the 

experiments must be conducted using that same location such that any signal from the 

cantilever will be valid for this location.   

10. On the 600A main window click on Calibrate>Force to open the 470A Force Calibration 

windows, see .  Under Configuration Stages click on Noise Profile.  This will display 3 signals:  N, 

L and SUM.  The N signal (red line) measures cantilever deflection and it is the signal used to 

obtain force.  The L signal (green line) measures twisting of the cantilever.  The SUM signal 

(blue line) measures the total light signal incident on the photodiode.  

11. Previously, the distance between the focal point and the Periscope was determined.  Use the 

XYZ motorized stages to position the cantilever at this location.  If required, move the 

cantilever to the face of the Periscope and then back it away from the Periscope by the focal 

distance.  

12. Move the cantilever perpendicular to the laser beam in both directions while monitoring both 

the N and SUM signals.  Use the position readouts in the 820A software to monitor the 

movement.  Center the cantilever on the maximum SUM signal location, this corresponds to 

the laser being centered on the AFM Cantilever.  Note: This cantilever location determines the 

position of the cantilever that will be used when conducting experiments with a myofibril.  Zero 

the position readout on the 820A software so that you can return to this location.  

 

Figure 9 Orientation of AFM Cantilever and Needle with respect to Periscope 
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Troubleshooting note: If the position that corresponds to the laser being centered on the cantilever is out 

of the field of view of the microscope/camera then the laser beam location, as it leaves the Periscope, 

needs to be adjusted, see section 2.5.3. 

Troubleshooting note:  If the laser spot is greater than the cantilever width, do the following:  

• Double check that the laser fiber optic is connected properly to the 470A Head. 

• Use a piece of paper to verify the location of the focal region of the laser beam from the 

periscope.  Move the paper close to the periscope.  Then adjust the Periscope location 

forwards and backwards to try and move this focus to the middle of the field of view if it 

is not there already.  If the Periscope cannot be moved further back because it is at its 

limit already, then the laser optics will need to be adjusted inside the head and Aurora 

Scientific should be contacted for a proper procedure to do so.   

 

13. Verify the elevation of the laser spot on the cantilever by moving the cantilever upwards until 

the SUM signal drops close to zero (the laser beam will be passing below the tip of the 

cantilever).  Check the position readout on the 820A software to determine how far the needle 

moved between its operating location and the end of the cantilever.  If this distance is greater 

than the length of the cantilever (450 µm) then the operating location is on the chip rather 

than on the cantilever.  The location of the operating point will need to be moved in order to 

conduct experiments.  The distance of the laser focal point above the end of the cantilever sets 

the sensitivity of the system.  Sensitivity is maximum when the focal point is near the cantilever 

tip and decreases as it moves towards the chip end of the cantilever.   

14. Verify that the cantilever surface is reflecting properly.  If a surface imperfection is at the focal 

point, then false displacement readings will result.  If the N, L and SUM signals don’t look 

correct try moving the cantilever a small distance up or down to see if it improves the signals.  

15. Monitor the N signal while moving the cantilever in the Y direction across the laser beam and 

note how the signal varies.  The signal should be symmetric and smooth around its maximum 

value as the cantilever moves across the laser beam.  If the trace has any irregularities (e.g., 

more than one peak) then the laser beam is distorted by some imperfection and the laser 

beam or cantilever elevation should be changed to a cleaner area on the cantilever.  

16. Perform the same procedure as in the previous step while moving the cantilever up and down.  

Once again, readjust the position if the signal is distorted.  

17. Once the operating location for the cantilever has been determined, zero the XYZ readout for 

the cantilever at this operating location.  Also create a waypoint for the cantilever at this 

location.  This waypoint is critical as it allows you to return the cantilever to the experiment 

measurement location at any time.   

3.3.1 Noise Profile 

The Noise Profile function is used to record background light which will be subtracted from the recorded 

signal when experiments are run.  Background noise is measured by the photodiode along its entire 

length of travel.   
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1. Since all calibration and all experiments must be run with the cantilever at its current location, it 

is very important that the current location is recorded.  Before starting the Noise Profile 

calibration, use the Zero buttons in the 820A software to zero the relative position of the 

cantilever.  Also create a waypoint for the cantilever at this time which will allow you to easily 

return to the exact calibration location of the AFM cantilever.    

2. Move the cantilever completely out of the field of view.  We suggest moving the cantilever to the 

right by 3mm.  To do this use the 820A software, set a Jog distance of 3mm, ensure the control is 

set on the Right Probe and press the Right Arrow.   

3. Move the 340A Piezo Length Controller and needle out of the field of view using the same 

procedure as for the cantilever.  In this case select the Left Probe and press the Left Arrow to 

move the needle to the left by the Jog distance.  

4. The 470A will pick up some of the ambient light in the lab plus light from the microscope.  If you 

intend to use the microscope light during experiments, then ensure the light is on and is set to 

the normal illumination level you use during an experiment.  If your experiments are to be 

conducted in the dark, then turn off the room lights and the microscope light to ensure the noise 

profile is taken in the conditions that will be present during the experiments.  Note: If the 

experiments are conducted in light conditions then verify the correct solution level in the bath 

and ensure that a meniscus does not form.  The solution level and the presence of a meniscus 

affect the lighting conditions in the bath and therefore the noise profile. 

5. On the ASI470A Calibration window under the Configuration Stages heading, click on Noise 

Profile.  Under the Profile Parameters heading choose the number of samples for the scan.  This 

setting controls how many samples will be taken along the entire excursion of the photodiode.  

Since the total excursion is a fixed number, the number of samples also sets the distance 

between each sample.  A more accurate profile is obtained when more samples are taken.  We 

recommend using 41 samples which corresponds to a reading every 0.25mm of photodiode 

travel. 

6. Click on the Take New Noise Profile button to run the Noise Profile scan.  Note: This will detect 

the noise throughout the full range of the N signal.  Most of the background noise comes from 

the microscope light.  If the experiment is performed in the dark then solution level will not be a 

factor that affects the signal, however, video observation of the experiment will be difficult.  

7. The Noise Profile should look similar to that shown in Figure 10Error! Reference source not f

ound. on the bottom graph (SNL Noise Profile). 

8. Click on File>Save to save the Noise Profile scan for the session. 
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3.3.2 Diode Position Profile  

The Diode Position Profile function is used to measure the signal level over the range of movement of the 

photodiode stage.  This profile is used to determine the optimum position for the photodiode before 

starting experiments.     

1. Use the AFM Cantilever waypoint to reposition the cantilever at the operating location.   

2. Leave the 340A Piezo Length Controller needle in its current location so that it doesn’t affect the 

measurement of the signal profile (off to the left side and not between the cantilever and 

periscope).  

3. On the ASI470A Calibration window under the Configuration Stages heading, click on Diode 

Position Profile.  Under the Profile Parameters heading leave the number of samples for the scan 

the same as you used for the Noise Profile.  Note: it is not strictly necessary that you use the 

same number of samples for both the noise profile and the diode position profile, but it is 

recommended.  As before, a more accurate profile is obtained when more samples are taken.  

Figure 10 Noise Profile Stage of Calibration 
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We recommend using 41 samples which corresponds to a reading every 0.25mm of photodiode 

travel. 

4. Click on the Begin SNL Profile button to run the Diode Position Profile scan.  Note: This scan will 

measure the amount of signal for each position of the photodiode throughout its full range.  

5. The Diode Position Profile should be similar to that shown in Figure 12.  Note: The Diode Position 

Profile shows the Diode Profile after automatically subtracting the Noise Profile.  

6. Click on File>Save to save the Diode Position Profile scan for the session.  Note: you can overwrite 

the previous file you saved during the Noise Profile since the save function incrementally saves all 

data collected during the calibration. 

  

Location of 
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Figure 11 Diode Position Profile with Overlay of Laser Spot on Quadrant Detector 
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3.3.3 Diode Profile Analysis 

The Diode Profile Analysis function is used to set the optimum position for the photodiode before starting 

experiments.   

1. After completing the Diode Position Profile, the window should appear as in Figure 12. 

2. Choose a Fit Method and press the Recalculate Fits button.  A yellow dot should appear on the N 

Signal Length Fit graph at the bottom of the window.   

3. Under the Diode Position heading use the Setpoint (mm) control to move the yellow dot so that it 

lies on the intersection between the Reference Profile line and the 0-volt line.   

4. Press the Set button to move the motor to the location specified in the Setpoint data entry box. 

Note: The diode profile and the zero location can vary if the experiment is conducted in the light 

or in the dark as the plot depends on the background subtraction step.  After pressing the Set 

button, you should note that the N signal is very close to 0 volts.   

Figure 12 Diode Position Profile Stage of Calibration 
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5. Click on File>Save to save the Diode Profile Analysis for the session.  Note: you can overwrite the 

previous file you saved during the Diode Position Profile since the save function incrementally 

saves all data collected during the calibration. 

Troubleshooting note:  If the Diode Profile Analysis looks incorrect, this could be due to any of the 

following reasons: 

1. The Noise Profile was performed with the cantilever in the laser beam.  The results of the 

Diode Profile Analysis will then show a flat line since the Diode Position Profile and the Noise 

Profile are the same and the difference of these two signals is zero.  

2. The amount of illumination or the solution level was different when performing the Noise 

Profile and when performing the Diode Position Profile.  Conditions must be the same for 

both profiles.  The only difference between the two profiles should be the presence or 

absence of the AFM Cantilever.    

3. The laser beam is not well focused on the cantilever which can be due to cantilever 

positioning or due to laser beam alignment.  You must make sure that the cantilever is 

returned to its correct alignment location before taking the Diode Position Profile.  Always 

ensure that the laser is aligned before starting the calibration procedure.  Likewise, ensure 

the cantilever is correctly positioned in the laser beam for maximum SUM signal before 

starting the calibration.   

3.3.4 Cantilever Deflection Profile 

The Cantilever Deflection Profile measures the change in N signal for given changes in cantilever 

deflection and then fits the data to produce a relation that is used during experiments to convert N to 

deflection.  In order to perform this calculation, the 340A needle must be placed behind the cantilever 

and then used to deflect the cantilever a known amount while monitoring the change in N signal.  The 

calibration should provide a positive slope when the cantilever is deflected towards the periscope and a 

negative slope when deflected away. 

Troubleshooting note: If the needle does not go behind the cantilever then the angle or rotation of 

the needle needs to be adjusted to allow access to the back of the cantilever. 

1. Make sure the 340A Piezo Length Controller is turned on and that piezo has been calibrated.  Also 

make sure that you have pressed the Zero Lout button on the main 600A window.  We also 

recommend that you use the Setup menu to set a non-zero Lo value.  Lo is normally the myofibril 

length so, at this point, simply type in a placeholder value for Lo say 50 or 100 µm.  The 600A 

program treats Lin and Lout as absolute values, not as relative ones, for this reason Lo should be 

a non-zero value.  The software also contains safety limits on the movement of the length 

controller and this safety value is calculated as a multiplier of Lo.  If you make Lo=0.0 then the 

safety values for maximum and minimum Lout will both be 0.  This can result in no movement of 

the motor.   

2. Using the left XYZ stage, place the needle behind the cantilever to prepare the system for the 

displacement calibration.  Set the elevation of the needle as close as possible to the elevation of 

the myofibril when it is attached to the cantilever.  The needle should have some overlap with the 
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tooth.  When the needle touches the cantilever, the signal will get a bit noisier.  Move the needle 

into contact with the cantilever and note the change in the N value.  Back the needle away from 

the cantilever until N returns to the no-load value.  This is the zero-deflection starting point for 

the calibration.  Note: if the needle is not clean it can stick to the cantilever and result in pulling 

the cantilever in the opposite direction as you try to reduce the deflection to zero.  Therefore, 

take note of the N signal prior to touching the cantilever with the needle, if the N signal is not 

equal to this value then you are not at zero deflection. 

3. Under Configuration Stages click on Cantilever Deflection Profile which should show the window 

as in Figure 13.   

 

4. Set the light in the room and the microscope illumination the way it will be during the 

experiment.  

5. Under the Deflection Parameters heading check that the Length In value is the same as what you 

set Lo to through the Setup menu (step 1 above).  Note:  If you set the Length In value to 

something completely different than the current value of Lo the length controller will change the 

length from the current Lo value to the Length In value you set plus the Length Step Size that you 

Figure 13 Cantilever Deflection Profile Stage of Calibration 
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specify.  This can result in very large movements of the length controller and could result in 

breakage of the cantilever.   

6. Set the Length Step Size to an appropriate value, we recommend a size of 1 µm or less.   Note: 

the maximum deflection of a cantilever is only about 20µm.  Never set Length Step Size larger 

than 20µm.  Note: for most setups the signal from the cantilever will go off scale after about 

15µm of deflection. 

7. Click on Take Measurements.  This causes the software to measure the current N signal and then 

move the needle by the Length Step Size you set. The measured value will be plotted on the 

display versus the known deflection. 

8. The software will continue to collect a profile of deflection versus N signal.  The values will be 

plotted on the window as you take them.  At some point you will note that the N signal reaches a 

plateau and may even start to drop.  This behaviour marks the end of taking measurements.  The 

reason for the plateau and the drop is explained below.  You can press Stop Measurements when 

the output plateaus or let the measurements continue and then remove these plateau points 

from the fit later. 

9. When the measurements are complete, press the Perform Linear Fit button to calculate the N 

versus deflection curve.  

10. If any points in the curve are not valid, then you can use the Remove Point button to remove that 

point.  Simply click on a point on the graph to highlight it.  Then press the Remove Point button 

(Rem Point).  Once you have removed non-valid points press the Perform Linear Fit button again 

to recalculate the fit.   

11. Click on File>Save to save the calibration for the session.  Note: you can overwrite the previous 

file since the save function incrementally saves all data collected from each step of the 

calibration. 

 

Note:  It is important to understand that the results of an experiment must be analyzed with the 

calibration curves calculated just prior to that experiment and not using curves obtained from previous 

experiments.  

Understanding the Cantilever Deflection Profile 

The Cantilever Deflection Profile will result in a plot of the N voltage versus deflection of the cantilever. 

Figure 14 provides a graphical explanation for the shape of this profile.  Case 1 shows the ideal starting 

location of the reflected laser spot for zero cantilever deflection.  The laser is centered on the quadrant 

detector and therefore the N signal is zero.  This corresponds to the first point obtained when taking 

measurements, the no load or zero deflection point.  Case 2 shows the reflected laser spot as the 

cantilever starts to deflect; the spot moves upwards in the diagram resulting in an increasing positive N 

signal as the cantilever deflects.  Case 3 illustrates the beginning of the plateau, almost all the reflected 

light is in the upper two quadrants and therefore N changes slowly with increasing cantilever deflection 

(the N signal is flattening out).  Case 4 shows the reflected beam fully on the two upper quadrants and 

this corresponds to a constant and maximum N signal (the plateau).  The N signal stays constant with 

increasing cantilever deflection.  Case 5 shows the end of the plateau; the reflected laser light is still fully 
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on the upper two quadrants resulting in a constant and maximum N signal.  Case 6 shows the reflected 

laser spot moving off the top of the upper two quadrants which results in the N signal reducing with 

increased cantilever deflection.  The region up to the plateau (up to case 4) defines the useful deflection 

range of the cantilever.  In order to have enough range for myofibril studies, there should be at least 5 - 

10 µm of cantilever deflection before the signal starts to plateau.  If this is not the case, then you will 

need to lower the cantilever with respect to the laser beam in order to reduce the sensitivity of the 

measurement (place the laser spot farther from the free end of the cantilever).  Likewise, if deflections of 

more than 20µm don’t result in the N signal being on the plateau, then the sensitivity is too low.  In this 

case the cantilever beam should be raised with respect to the laser beam (place the laser spot closer to 

the free end of the cantilever). 

The actual signal from the displacement calibration will have some nonlinearity to it.  This nonlinearity is a 

consequence of the way the quadrant detector records the signal which corresponds to the location of 

the laser spot of the quadrant detector.  The detector measures changes in voltage off the center point of 

the detector, however, because the laser spot is circular any deviation from that center point will have a 

corresponding nonlinear change in voltage. 

 

Troubleshooting note:  If the displacement calibration plot has a negative slope when pushing from the 

backside of the cantilever beam, then the zero position is not set correctly.  This means that the laser 

beam is sitting at the bottom part of the quadrant detector resulting in a varying negative signal.  To 

correct this, perform the Diode Profile Analysis again and set the detector motor to the location that 

provides a N signal equal to 0.  

 

Troubleshooting note:  If the N signal reaches the plateau before 5 µm of cantilever deflection then the 

Cantilever Deflection Profile must be discarded.  To solve this problem the location of the laser beam on 

the cantilever needs to be changed.  The laser beam must be moved closer to the fixed end of the AFM 

Cantilever (reduce the sensitivity of the N signal with cantilever deflection).  To accomplish this, use the Z 

axis control in 820A software to move the AFM Cantilever down.  If you move the AFM Cantilever, then 

you will need to redo all the Configuration Stages in the Force calibration.  Also ensure that you zero the 

820A position at the new location and create a new AFM cantilever waypoint. 
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This figure shows the correlation between the location of the laser spot on the quadrant detector and the 

corresponding change in the N signal recorded by the detector. This is the signal that changes when the cantilever 

bends which, in turn, moves the laser spot vertically on the detector. 

   

3.3.5 Verifying the Results of the Cantilever Deflection Profile 

The Cantilever Deflection Profile assumes that there is no compliance in the 340A Piezo Length Controller 

needle.  In other words, it assumes that if you move the piezo motor a given amount that the cantilever 

beam also moves the same amount.  This should be verified using the 901D software.   

1. Start the 901D software.  Make sure the software is calibrated for the objective magnification you 

are using.  

Case 1: The laser spot is in the 
middle of quadrant detector. 

Change in voltage is zero 

 

 

Quadrant detector  

N signal   

Laser spot 
 

 

Case 2: The laser spot moves 
upwards resulting in a high 

rate in the change of voltage 

 

 

Case 3: The laser spot moves 
upwards resulting in a slower 
rate in the change of voltage 

 

 

Case 4: The laser spot moves 
upwards past the centerline 

resulting in no change in 
voltage  

 
 

Case 5: The laser spot moves 
upwards still past the 

centerline resulting in no 
change in voltage  

 
 

Case 6: The laser spot moves 
upwards outside the detector 

range and the change of voltage 
starts to drop  

Figure 14 The N Signal Voltage at Various Laser Beam Locations on the Quadrant Detector 
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2. Open the Tools menu and place a measurement point on the tip of the cantilever prior to 

deflecting the cantilever.   

3. Using the piezo motor, deflect the cantilever an amount equal to the usable range of the 

cantilever (the point on the N versus deflection curve before the N signal plateaus).   

4. Place a second measurement point on the cantilever tip while it is deflected.   

5. Compare the actual cantilever deflection (measured with the 901D software) to the deflection of 

the piezo motor.  If these values are not within 5% of each other, then check the piezo motor 

calibration.  If the calibration is correct, then replace the piezo needle as it has too much 

compliance. 

3.3.6 Cantilever Parameters 

The Cantilever Parameters window, (see Figure 15), calculates the stiffness (Force Constant) of the AFM 

cantilever beam.  This stiffness can be calculated from the physical parameters of the cantilever or simply 

entered, if you know it. 

1. If you intend to let the program calculate the stiffness from the physical properties of the 

cantilever, then set the Calculation Method to either Rectangular Cross-section Beam or to 

Trapezoidal Cross-section Beam.  The simplest method is the Rectangular setting which calculates 

stiffness assuming a rectangular cross-section.  However, most silicone etched AFM beams are 

trapezoidal in cross-section.  The Trapezoidal method will produce a more accurate stiffness 

calculation, but it depends on the user being able to accurately measure the width of the beam 

on the top and bottom faces.   

2. Set the AFM Cantilever material by clicking on the material under the heading Elastic Modulus (E).  

This sets the Young’s Modulus of the cantilever.  If you are using a material not listed, then click 

on Other and enter the E value in GPa. Note: the AFM cantilevers supplied with the 470A are 

made from silicon. 

3. Enter the Length, Width and Thickness of the cantilever in µm.  Note: for Trapezoidal you will 

need to enter two widths. 

4. The program calculates the Force Constant when all values are entered.     

5. Alternatively, if you select Other under Calculation Method, then you can simply enter the Force 

Constant value yourself.  The entered value can come from the manufacturer or from some other 

calculation that you perform outside of the program.  

6. Click on File>Save to save the calibration for the session.  Note: you can overwrite the previous 

file since the save function incrementally saves the data collected for each of the Configuration 

Stages. 
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3.4 Perfusion System Preparation  

Before starting an experiment, the perfusion system must be prepared.  The perfusion system includes all 

hardware required: syringes, valves, mounting parts and the fast-step perfusion motor that is used to 

switch the flow from Relax to Activate.   

1. Open the Valve Controller window by clicking on the Valves menu heading on the ASI470A Status 

Window.  

2. Roughly position the fast-stepping motor and the double-barrel pipette that is connected to the 

Relax and Activate lines in the bath.  Ensure that the pipette does not touch the micro-tools.  The 

final location of the perfusion pipette will be set after attaching the myofibril.   

3. On the 820A software control window, make sure you have set a waypoint for the current 

location of the AFM cantilever and the piezo motor.  Now press the Retract button to move the 

micro-tools upwards and away from the bath.   

4. If desired, tilt and lock the 470A Head in the up position for easy access to the bath.   

5. Fill the syringes of the perfusion system with 6 ml of solution.  There are only 6 valves in the 

system so if you want to maximize the number of pCa solutions you can run we suggest you 

connect the Relax solution using a manually controlled on/off valve.  This will then leave the 6 

electronically controlled valves for activate solutions.    

Figure 15 Cantilever Parameters Stage of Calibration 
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6. Press the Home button on the Valve Controller window to set the perfusion motor to its home 

position, see Figure 16.    

7. Start the flow of both the relaxing solution and the desired activation solution by clicking on the  

valve buttons on the Valve Controller window, see Figure 16.  Keep track of the bubbles driven 

through the tubes by the fluid.  Ensure all bubbles are removed from each tube.  If you intend to 

use multiple activating solutions, then you must remove the bubbles from each valve line.  To do 

this, turn on each of the valves, one at a time, to remove the air bubbles.   

8. If the solution does not come out of the tubes, or it is too slow, then insert a syringe piston into 

the syringe and press it slightly to add extra pressure to the tube.   Alternatively, you can raise the 

syringes higher above the bath.  

9. Flush the fluid from each of the tubes until no more bubbles pass through.  It may take up to 1ml 

of solution to fully flush the tubing. 

10. Shut off all valves.  

11. Remove all the fluid from the bath using the pump (suction system).  Using a pipette, fill the bath 

with water a couple of times, draining the bath between fills.  Next fill the bath with Relax 

solution a couple of times and remove it with the pump.  Finally fill the bath with Relax.  

Figure 16 Valve Controller Window 
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Note: there are two operating modes for the valves that can be set by clicking on the Setup menu item at 

the top of the window.  The two modes are Run and Setup.  In Run mode only one valve can be on at a 

time and when you press a new valve button the current valve that is on is automatically shut and the 

selected valve is opened.  In other words the valve buttons act as radio buttons with only one button on 

at a time.  In Setup mode you can have any number of valves on simultaneously and clicking on a valve 

button only cycles that particular valve on and off.  Note: if you want to be able to switch the Relax on 

and off using valves then you will need to use the Setup mode so that you can have both Relax and a 

selected Activate valve on simultaneously.  The Setup mode is also good for draining the system as all 

valves can drain at the same time.   

 

3.5 Attaching a Myofibril  

1. Before starting, press the Zero Lout button on the 600A main window.  This will set the piezo 

length controller to its centered position.  

2. If the 470A Head is tilted up, then lower it into the bath. 

3. Retract the micro-tools out of the bath. 

4. Pump out the relaxing solution and keep a little solution at the bottom of the bath, 1 mm height 

of solution is recommended.  

5. Using a pipette, take a small amount of the sample containing the muscle myofibrils and place it 

into the bath with the relaxing solution.  

6. Wait for 2 min to let the myofibrils settle onto the coverslip. 

7. Using 2 pipettes add relaxing solution and then remove it in order to remove excess matter that 

will be floating in the solution and not yet stuck on the coverslip.  Do not use the pump to take 

out the solution as it will suck the solution from the bottom of the bath and it might remove 

myofibrils that are on the coverslip already. 

8. Fill the bath with relaxing solution to the top of the metal part of the bath and make sure no 

meniscus forms.  The surface of the fluid must be flat, so that it doesn’t affect the signal.  If the 

experiment is performed in the dark, then the meniscus does not affect force measurements and 

therefore it is not necessary to control it. 

9. Bring the micro-tools back into the bath by returning them to the measurement waypoint.  Now 

use the manual push-button controls, or the on-screen controls, to separate the tools away from 

each other and away from the periscope.  This provides some freedom of movement required 

when attaching a myofibril.  Ensure that the micro-tools are in the field of view of the 60x 

objective. 

10. Move the microscope stage around to find a good myofibril bundle.  Make sure that the bath is 

not moved so much that the periscope and tools hit the edge of the bath.  Note:  A good 

myofibril bundle is one that is long because it will be easier to handle with the micro-tools. If 

there are a lot of myofibrils in a bundle (more than about 10) then the force generated by the 

bundle might be too great for the cantilever to measure and the signal will go off scale.  Look for 

bundles with sharp contrast on the striation pattern, this typically indicates a healthier bundle. 
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11. Once the myofibril bundle is located go back to the 4x objective and place some glue on the 

coverslip in a location away from the bundle.  This is best done by putting some glue on the end 

of a tube and then placing the glue in the bath manually while observing through the oculars. 

Make sure the glue sticks to the coverslip.  However, do not press too hard with the glue stick or 

you could damage the coverslip or change its elevation at the glue location. 

12. Applying glue to the 340A needle. 

a. Move the 340A needle above the glue. 

b. Move the needle down until it touches the coverslip. 

c. Move the needle forward and into the glue. 

d. Pull the needle up and it should have glue on its tip.  If not, then repeat this process until 

some glue can be seen on the needle tip. 

13. Applying glue to the AFM Cantilever. 

a. Move the AFM Cantilever over top of the glue. 

b. Move the cantilever down until it is just above the coverslip. 

c. Move the cantilever forward and into the glue. 

d. Pull the cantilever up and it should have glue on the tip.  If not, then repeat this process until 

some glue can be seen on the cantilever tip. 

14. Bring the micro-tools in the field of view on top of the selected myofibril. 

15. Bring the cantilever to one end of the myofibril.  

16. Move down and touch the myofibril, continue to move down until the cantilever touches the 

coverslip.  If required, move sideways as you touch the myofibril to rub it into the glue.  

17. Bring the needle to the opposite end of the myofibril.  

18. Move it down and touch the myofibril.  Move down with the needle and get the glue to rub into 

the myofibril.  Move further down until the needle touches the coverslip. 

19. Set the 820A control to slave probes, this will cause the two probes to move in unison.   

20. Lift the probes incrementally from the coverslip until you see the myofibril come clear of the 

coverslip.   

21. If necessary, use the 820A Rotate function to rotate the myofibril so that it aligns with the laser 

beam axis (X axis).  The needle must be located on the side closest to the Periscope with the AFM 

Cantilever farther from it.  

22. Once rotated, use the stored AFM Cantilever waypoint to reposition both the AFM Cantilever and 

the needle at the experimental calibration location in front of the periscope.   

3.6 Setup the Perfusion Flow  

1. Verify that the flow from the double barrel pipette is what is needed for the experiments and 

insert the plungers into the syringes to ensure that the flow is occurring.  

2. Bring the double barrel perfusion tube into the solution. 

3. Using the knobs on the perfusion tube translation stages, move the tube into the solution and 

close to the micro-tools.  Make sure not to touch the needle or the cantilever.  Place it on the 

right or left side of the setup touching the coverslip as shown in Figure 17. 
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4. Use the Perfusion Motor Controls on the Valve Control window to set the location of the pipette 

so that the myofibril is bathed in relax solution.  Once this position has been determined, store 

the position as a button that you label Relax. 

5. Use the Valve Control window to set the location of the pipette so that the myofibril is bathed in 

activate solution.  Once this position has been determined, store the position as a button that 

you label Activate. 

6. Press the Relax button to return the Perfusion motor to the relax solution position. 

 

3.7 Running an Experiment  

At this point the 470A is calibrated and located in the operating location with a myofibril attached.  

Experiments are run in a similar manner to any other muscle mechanics experiment.  Create a test 

protocol or series of protocols, combine these protocols in a sequence and then execute the sequence.  

Data is stored automatically whenever you run a sequence, so it is the preferred method of running an 

experiment.   

3.7.1 Create a Protocol 

Below is an example of a basic protocol that will move the perfusion motor to the Activate position, 

trigger HVSL to record a contraction, collect data from a myofibril contraction and then switch the 

perfusion motor back to the Relax position.  This protocol assumes that you have turned on both the 

Relax valve and one of the pCa valves so that both solutions are flowing from the end of the double barrel 

pipette.   

Figure 17 Image showing Location of Double Barrel Pipette, Periscope, Needle and Cantilever 
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The Perfusion command is used to move the double barrel pipette from the Relax to the Activate 

positions that were preprogrammed into the Perfusion Motor control.  The parameter associated with 

the Perfusion command is the number of the preset button you want to activate.  Note: The Home 

button is not included in the list.  The first user-defined button corresponds to button 1.  Prior to running 

the protocol, the 901D HVSL program must be set to Record mode with the trigger type set as 600A.  On 

the Record window you determine the duration of the recording and whether SL values, SL images or 

both are recorded in the data file.  In Table 4 the protocol collects 20 seconds of data so the Recording 

should be set for the same duration.  After creating the protocol, store it as MyofibrilContraction.pro. 

Step Time Function Parameters 

1 0.0 Data-Enable  

2 0.1 SL-Trigger 0 ms 

3 100.0 Perfusion 2 

4 19999.0 Perfusion  1 

5 20000.0 Data-Disable  

6 20001.0 Stop  

Table 4 Simple Protocol to Collect Data from a Myofibril Contraction 

 

The Valve command is used to turn any of the six valves on or off.  In this example we have the relax 

solution connected to valve 1 and the desired pCa solution connected to valve 3.  The parameters 

associated with the Valve command are six numbers that are 0 for valve off or 1 for valve on.  The valves 

are numbered 1 through 6 and these six numbers correspond to the valves in order.  After creating the 

protocol, you can store it as ValvesOn.pro.              

Step Time Function Parameters 

1 0.0 Data-Enable  

2 100.0 Valve 101000 

5 200.0 Data-Disable  

6 201.0 Stop  

Table 5 Simple Protocol to Turn on Vavles 1 and 3 (Relax and pCa valves) 
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3.7.2 Create a Sequence 

It is a simple matter to create a series of protocols that perform the simple tasks that you may want to 

perform during an experiment.  Once these individual protocols are defined, they can be combined into a 

sequence which will automate the experiment including the saving of the data file(s).  Below is an 

example of a simple sequence that includes the two protocols created above.  First the Relax and Activate 

valves are turned on.  Then there is a delay of 20 seconds while we wait for the flow to stabilize.  After 

this we run the contraction protocol which takes SL images, moves the perfusion motor and collects the 

contraction data.   

Enable Protocol File Name Delay 

Time (s) 

Data File Name File 

Status 

1 ValvesOn.pro 20 Nodata1 OK 

2 MyofibrilContraction.pro 0 Contraction OK 

Table 6 Simple Sequence to Run Two Protocols 

Note: it is a simple matter to create another protocol called ValvesOff.pro that could be added to this 

sequence to turn off the valves after the experiment is complete.  As mentioned before, running the 

experiment using a sequence is preferable because you can execute multiple protocols plus the data is 

stored automatically. 

3.7.3 Measure the Myofibril and Set Up 600A 

1. Refresh the solution in the bath by pumping it out once and then manually adding relaxing 

solution back into the bath.  Be careful to get back the same level of solution and to not form a 

meniscus on the surface.  The video images will get brighter and darker as the meniscus changes. 

This is less critical if the experiment is conducted in the dark.  Note: When added or removing 

fluids from the bath be very gentle as the fluid flow could move the needle, cantilever or detach 

the myofibril that is attached between the micro tools. 

2. Set the myofibril to the initial length (Lo) dictated by your test protocol.  Some researchers set Lo 

by setting a starting sarcomere length, others set Lo by setting a starting tension.   

3. Lo set by sarcomere length.  Use 901D to measure the sarcomere length and then use the 340A 

front panel Offset knob to adjust the overall myofibril length to the desired starting sarcomere 

length.  

4. Lo set by resting tension.  Monitor the Force In signal and then use the 340A front panel Offset 

knob to adjust the myofibril tension. 

5. Measure the overall myofibril length using the measurement functions of the 901D HVSL 

software.   

6. Enter the myofibril length as the Reference Length (Lref) in the 600A Setup window.  Once you 

enter the reference length click on Zero Lout and then Record Lin.   
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7. From the 901D measurements you will also know the myofibril width, enter this value on the 

600A Setup window in the Diameter text entry box.  Pick a type of cross section that best 

matches the fiber.  Set the resting sarcomere length (SLo) as measured by HVSL.  If you know it 

you can also enter Fmax at this time.  Alternatively, enter Fmax later once you have measured it.  

Fmax is only used for plotting F/Fmax so it is not critical that it be set correctly at this time.   

8. Click on Record Fin to have the program record the resting tension.  Close the Setup window 

when complete. 

9. Set up the Record function in 901D HVSL for a time that matches your various protocols.  Set the 

trigger to 600A and enable it. 

10. Run the Protocol or Sequence that performs the experiment you want to perform.  

Troubleshooting note:  If during the experiment the myofibril is not contracting this could be due to any 

of the following:  

• The correct valves are not on.  Turn on the correct valves. 

• The pCa solution is not correct.  Replace the pCa solution with fresh solution. 

• The perfusion pipette is not properly aligned with the myofibril.  Use the Perfusion Motor 

Control to position the pipette at various locations to see if you can get the myofibril to 

contract.  If necessary, reset the Relax and Activate buttons.   

• There is not enough pressure in the syringes to obtain the desired flow.  Push in the plungers 

a small amount. 

• The double barrel pipette is clogged.  Remove the pipette and either replace it or clean it. 

Check the flow before returning the pipette to the bath.    

• The resting length was not set correctly and when contracted the myofibril doesn’t move 

enough to generate force on the cantilever.  Set resting length (resting tension) correctly. 

• The myofibril is not attached to one or both micro tools.  Reattach the myofibril. 

• The myofibril is not good.  Start with a new one. 

 

11. If activating solution was pumped into the bath, then refresh the solution in the bath by pumping 

it out once and then manually adding relaxing solution back into the bath.  Be careful to get back 

the same level of solution and to not form a meniscus on the surface.   

 

3.8 Cleaning the Micro Tools at the End of an Experiment  

3.8.1 Mechanical Cleaning of the Micro Tools  

1. Disconnect the myofibril by moving the cantilever and the needle away from each other.  Then 

raise the micro-tools a small distance. 

2. For the needle:  Switch the objective to 4x magnification.  Move the needle down until it touches 

the coverslip.  Keep going down until the needle starts to slightly slide on the coverslip.  Move the 

needle in a backwards direction (move the needle in a direction away from the tip of the needle) 

and the glue should start to come off.  Move up.  Repeat the process until the glue is off. 
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3. For the cantilever: Switch the objective to 60x magnification.  Bring the cantilever and the 

cleaned needle into the field of view.   Bring the cantilever to the coverslip and bend it slightly.  

Bring the needle on top of the tooth and go down onto the tooth while the cantilever is bending.  

Move the cantilever upwards.  This forces the glue off the cantilever and onto the needle.  Repeat 

the process until the glue is off.  When the glue is off the cantilever and on the needle, go back to 

4x magnification and remove the glue from the needle with the process explained in step (2) 

above.  

4. Verify that the needle and cantilever are clean using 60x magnification. 

3.8.2 Chemical Cleaning of the Micro Tools  

Try the mechanical cleaning procedure first.  If it is not successful, then try this chemical cleaning 

procedure.  The procedure for chemical cleaning of the micro tools depends on the type of glue used and 

the solvent for the glue.  If chemical cleaning is required, then it is best done after completing the 

shutdown procedure.   

Important notes for performing chemical cleaning of the micro tools. 

• Do not use the experiment bath for chemical cleaning as you can contaminate the bath.  

• Remove the Periscope from the 470A Head so that the periscope does not get immersed 

in the solvent. 

• Place a small amount of the solvent solution in a bath or on a microscope slide and only 

immerse the part of the micro tools that have glue on them.  This means that care must 

be taken not to place the cantilever too deep into the cleaning solution as this action 

could result in the solvent removing the glue used to attach the cantilever to the AFM 

Holder, ruin the reflective surface of the cantilever, or even change the cantilever 

stiffness.  

• Chemical cleaning may damage the cantilever and you may need to replace the 

cantilever more often when using this type of cleaning. 

 

3.9 Shutdown Procedure  

1. Remove some solution from the perfusion syringes then flush the rest into the bath using the 

Valve Controller to control the valves. 

2. Pump out the bath. 

3. Add 3 ml of water to each syringe and drive it out.  Do this with the micro tools immersed in the 

bath for more than 10 min to get them clean.  

4. Pump out the bath. 

5. Use the Retract function on the 820A software to remove the tools from the bath.  

6. Tilt the 470A Head up and lock it in the up position.  Use canned air to gently dry the Periscope 

exit surface.  

7. Add 2 ml of ethanol into each syringe and drive it completely out of the syringes to clean the 

perfusion tubes. 
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8. Pump out the bath.  

9. Remove the double barrel perfusion tube from the bath.   

10. Turn off the software, 340A Piezo Controller, 470A Controller and the microscope illumination.  If 

you intend to use the 470A within a few days time then leave the 820A Controller powered on.  It 

does not use much power and all position information will be retained.  Note: you do not need to 

leave the 820A software running, all position information is stored in the 820A Controller itself. 

11. Remove the suction tube from the bath suction needle.  

12. Turn off the cooling system and remove the cooling tubes from the bath.  Shake the tubes to 

cause the liquid to flow back into the cooling system and then stow the tubes. 

13. Remove the bath from the microscope and clean it by removing the coverslip and cleaning the 

bath with water and then ethanol to dry it.  Blow out the cooling tubes and the suction tube using 

canned air.  

14. Cover the microscope and the setup to protect them from dust. 
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4 Maintenance and Troubleshooting 

4.1 Maintenance 

4.1.1 Installing a Cover Slip on the Bath Plate 

The following procedure should be used to replace the cover slip on the bottom of the bath.  

Replacement is necessary whenever the existing cover slip is damaged, leaks or not optically clear.  

1. Remove any coverslip that is already at the bottom of the bath then clean the bath with 

ethanol and dry it with a clean wipe.  

2. Using your finger, or a small stick, spread high vacuum grease uniformly around the hole on 

the bottom of the bath plate.  Ensure that the grease is not too close to the hole because if it 

is then grease may spread into the hole when the cover slip is attached. 

3. Place a square coverslip on the bottom of the bath centered on the hole.  Press the cover slip 

onto the bath which will adhere the slip to the grease.  The swab end of a cotton swab is 

good for pressing the cover slip onto the bath.  When handling coverslips, avoid getting 

fingerprints and dirt on the slide, it is best to hold them by the sides.  

Note: The 470A has been designed to work with 22 mm square, No. 1 coverslips (0.13 – 0.17mm thick).  A 

gross of coverslips was included in the accessory kit that was shipped with the 470A.   

4.1.2 Cleaning the Periscope Optical Surfaces 

The periscope is a precision optical component that has an antireflective coating on the laser entry and 

exit faces.  This coating can be damaged by improper handling and cleaning.  Follow normal optical 

cleaning procedures to clean the entry and exit faces of the periscope.  Refer to Thorlabs optical cleaning 

procedures for a detailed description for cleaning optical surfaces. 

The non-optical surfaces of the periscope have been painted with a black paint to reduce stray light.  This 

paint can be dissolved by many standard laboratory chemicals.  For this reason, we suggest you do not 

clean the periscope with chemicals such as acetone, methyl ethyl ketone or other solvents.   

4.1.3 Attaching an AFM Cantilever to the AFM Holder 

This procedure should be performed during the initial setup of the system and any time the AFM 

cantilever breaks or loses its reflectivity due to overuse.  A new cantilever must be assembled onto the 

AFM Holder and integrated into the micro-manipulators associated with the system.  The following 

procedure should be followed when gluing the new cantilever to the AFM Holder.  

1. Using a dissection microscope, apply a small amount of UV setting glue to the AFM Holder where 

the cantilever will be attached.  Flatten the glue and make sure it is spread uniformly on the AFM 

Holder. 

2. Lift the cantilever out of the factory box using tweezers.  Be careful to hold the cantilever from 

the chip, do not touch the cantilever as it can be broken with minimal force.   Orient the chip so 

that the cantilever is pointing towards the tweezers.  Also ensure that the cantilever side of the 

chip is facing up. 

https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=9025
https://www.thorlabs.com/newgrouppage9.cfm?objectgroup_id=9025
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3. Place the cantilever directly onto the AFM Holder and orient it by pressing the chip into the 

machined sidewall of the AFM Holder.  Press the chip slightly into the glue.   

4. Using the dissection microscope, check the orientation and ensure the cantilever is snug to the 

machined side of the AFM Holder.  Press the chip onto the AFM Holder with the tweezers if 

necessary. 

5. Use the UV light to harden the glue, since the AFM chip is opaque only the UV glue around the 

edges will harden.  Ensure adequate glue is present on the edges of the AFM Holder.  Re-attach 

the AFM Holder to the AFM Holder Mount on the right XYZ stage.   

Note: AFM cantilevers may be purchased from Aurora Scientific Inc. by ordering model number 470-AFM.  

The cantilevers have the following dimensions: 450 ± 10µm Long x 50 ± 5µm Wide x 2 ± 1µm Thick.  The 

nominal spring constant (Force Constant) for these cantilevers is 0.2N/m.  

4.1.4 Making a Double-Barrel Pipette 

The type and shape of the double-barrel pipette is determined by the user and is a choice based on the 

number of solutions that need to be delivered to a myofibril and the overall dimensions.  Many options 

can be used to make these double-barrel pipettes.  Basic needle pullers and a torch can be used to make 

the pipette; however, using a micro-forge is better as it provides more accurate control of the dimensions 

of the double-barrel pipette.   

1. Start with Theta tubing and experiment with the micro-forge to obtain a draw and break that 

yields the required size tubes.  Normally the tubing is drawn down in size and then broken at a 

location that yields a double-barrel pipette tip that is about 200 µm in diameter.  Each barrel of 

the pipette is about 100 µm in diameter. 

2. After obtaining the correct exit size polish the tip of the pipette to ensure smooth, laminar flow 

out of the tip.  A rough or jagged tip will result in more flow disturbance around the myofibril. 

3. Test fit the pipette in the Perfusion Motor and determine if the pipette needs to be bent or 

otherwise altered for best access in the bath.  If so, heat the pipette and bend the tip accordingly.   

 

4.2 Troubleshooting 

The table below summarizes potential problems and their solutions.  If these recommendations do not 

resolve the problem, please contact Aurora Scientific Inc. for further assistance. 
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Problem Recommended Action 

Power LED does not light. The Power LED does not light until the internal micro controller completes 

its power-on checks.  Wait 5 seconds to see if LED comes on. 

Ensure AC power cord is firmly plugged into the wall receptacle and into the 

power supply receptacle on the back of the controller. 

Ensure the power switch is in the ON position. 

Ensure the line voltage is the same as listed on the tag shown on the back 

panel. 

Ensure the power source you plugged the power supply into is energized. 

Check the fuse located in the rear panel. 

Check that the internal power connector is attached to the circuit board. 

Alarm LED lit. There are 3 possible alarm conditions indicated by a lit Alarm LED. These are: 

1) Laser has overheated – turn off controller and allow the laser to cool 

off.  Ensure the controller is placed in an area that is at normal room 

temperature.  

2) ??? - ??? 

3) ??? - ??? 

Laser LED does not light. 600A software is not running – the only way to turn on the laser is to use the 

600A software.  

600A software is not configured for the 470A – use Models Attached screen 

to set Force Transducer to 470A.  Restart 600A software after making 

changes on the Models Attached screen. 

Ensure that the controller is communicating with the 600A software. 

Check the Ethernet cable is properly connected to the LAN connector on the 

front panel of the controller and to one of the router LAN ports (not the 

WAN port). 

No laser light exiting 

Periscope. 

Check fiber optic cable is correctly attached to head. 

Ensure laser is turned on. 

Check alignment of mirrors and periscope.   

Quadrant Detector Motor 

does not move when 

commanded to. 

Check that the quadrant detector motor is plugged into the front-panel 

HEAD DB-9 connector. 

HOME the quadrant detector motor – the motor will not move to 

commanded positions until it has been “homed”. 
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Motor is already at the commanded position.  

N, L and S signals are all zero. Check mini-DIN 8-pin cable is connected properly at front-panel connector 

labelled HEAD and at the head itself. 

Check BNC cables are properly connected between controller and 604A:  

N connected to Fin (A/D 2), L connected to AUX 1 (A/D 3), S connected to 

AUX 2 (A/D 4). 

Check laser is on and light is exiting periscope. 

Check optical alignment. 

Check AFM cantilever is intact and mounted correctly to AFM Holder. 

Check that quadrant detector motor is positioned at 5.0mm location (central 

location).  

N and L signals non-zero, S 

signal close to zero. 

Laser light is off the end of the quadrant detector – reposition quadrant 

detector motor to 5.0mm position. 

Check optical alignment. 

Check AFM cantilever is properly aligned to reflect laser light. 

N, L and S signals are all non-

zero and relatively large. 

The S signal indicates light on the quadrant detector, but the large N and L 

signals indicate that the reflected laser light is not centered. 

Check optical alignment. 

Check location of quadrant detector motor.  Set to 5.0mm. 

Check rotation angle of AFM cantilever holder (AFM must be parallel to exit 

face of periscope). 

Fast-Step Perfusion Motor 

does not move when 

commanded to.  

Check that the motor connector is plugged into the back-panel DB-9 

connector. 

Check that the controller is properly connected to the 600A software. 

HOME the perfusion motor – the motor will not move to commanded 

positions until it has been “homed”. 

Motor is already at the commanded position. 

Valves do not turn on and off 

when commanded. 

Check that the valve connector is plugged into the back-panel DB-15 

connector. 

Check that the controller is properly connected to the 600A software. 

Check the operating mode of the valves using the Setup command on the 

Valve window. 

Table 7 470A Troubleshooting Chart 
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5 Performance Guarantee, Technical Support, Warranty and Repair 
Information 

Aurora Scientific is dedicated to providing you with products that allow you to meet your research goals.  

For this reason, we offer a performance guarantee, technical support and a new product warranty. Our 

performance guarantee ensures you purchase the correct instrument for your research.  Technical 

assistance is always free and will be available for the life of your product.  If you do have a problem with a 

product then please know that all Aurora Scientific products are covered by a three-year warranty 

covering both parts and labour.  If you need to return a product to us for repair, then consult the final 

section of this chapter for returns information. 

 

5.1 Performance Guarantee  

Our performance guarantee states: if for any reason a new product does not meet your research needs 

then you can return it to Aurora Scientific for exchange or a full refund.  The performance guarantee only 

applies to new products and must be exercised within 60 days of receipt of the instrument.  

 

5.2 Technical Support  

Technical assistance is always free and will be available for the life of your product. Please don’t hesitate 

to contact us if you have any technical support issues.  Contact us by telephone, email, fax, or regular 

mail.   

 

5.3 Technical Support Contact Information and Return Shipping Addresses 
Canada, USA, South America, Middle East, Africa 
Aurora Scientific 
25 Industry St., Unit 1 
Aurora, Ontario, CANADA  
L4G 1X6  
Attn: RMA Returns 
Tel: +1-905-727-5161 
Fax: +1-905-713-6882 
Email (all Aurora Scientific Offices): techsupport@aurorascientific.com 
Web Site: AuroraScientific.com  
 
Europe 
Aurora Scientific Europe 
8 Terenure Place 
Terenure 
Dublin, D6WY006, Ireland 
Attn: RMA Returns 
Tel: +353-1-525-3300 
Fax: +353-1-443-0784  

mailto:techsupport@aurorascientific.com
http://www.aurorascientific.com/
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Asia, Australia, New Zealand 
Aurora Scientific Asia 
Unit C, 10/F 
Charmhill Centre 
50 Hillwood Road 
Tsimshatsui, Kowloon, Hong Kong 
Attn: RMA Returns 
Tel: +852-3188-9946 
Fax: +852-2724-2633 
 
Distributors 
Japan 
Kantoh Electronics Co., Ltd. 
1-25-14, Nakacho, Meguro-ku 
Tokyo, 153-0065, Japan 
Tel: +81-03-5773-5028 
Fax: +81-03-5773-5029 
Email: info@Kantoh-elec.co.jp 
Web site: http://www.kantoh-elec.co.jp 
 

5.4 Warranty 

Products manufactured by Aurora Scientific Inc. are guaranteed to the original purchaser for a period of 

three (3) years.  Under this warranty, the liability of Aurora Scientific is limited to servicing, adjusting and 

replacing any defective parts that are of Aurora Scientific manufacture.  Aurora Scientific is not liable to 

the customer for consequential or other damages, labour losses or expenses in connection with or by 

reason of the use or inability to use the products manufactured by Aurora Scientific.   

Guarantee of parts and components not manufactured by Aurora Scientific shall be the same as the 

guarantee extended by the manufacturer of such components or parts.  Where possible such parts 

returned to Aurora Scientific will be sent to the manufacturer for credit or replacement.  Ultimate 

disposition of these items will depend upon the manufacturer's decision.   

All shortages must be reported within ten (10) days after receipt of shipment. 

Except where deviations are specified in literature describing particular products, the limited warranty 

above is applicable to all Aurora Scientific products, provided the products are returned to Aurora 

Scientific and are demonstrated to the satisfaction of Aurora Scientific to be defective. 

Transportation costs of all products returned to Aurora Scientific must be borne by the customer and 

products must be returned to Aurora Scientific within three years after delivery to the original purchaser.  

Aurora Scientific cannot assume responsibility for repairs or changes not authorized by Aurora Scientific 

or damage resulting from abnormal or misuse or lack of proper maintenance. 

Repair or service work not covered under the limited warranty will be billed at current service rates.   

NO EXPRESS WARRANTIES AND NO IMPLIED WARRANTIES WHETHER FOR MERCHANTABILITY OR FITNESS 

FOR ANY PARTICULAR USE, OR OTHERWISE OTHER THAN THOSE EXPRESSLY SET FORTH ABOVE WHICH 

ARE MADE EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES, SHALL APPLY TO PRODUCTS SOLD BY AURORA 

mailto:info@Kantoh-elec.co.jp
http://www.kantoh-elec.co.jp/
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SCIENTIFIC INC, AND NO WAIVER, ALTERATION OR MODIFICATION OF THE FOREGOING CONDITIONS 

SHALL BE VALID UNLESS MADE IN WRITING AND SIGNED BY AN EXECUTIVE OFFICER OF AURORA 

SCIENTIFIC INC. 

 

5.5 Returning Products to Aurora Scientific for Repair  

There are a few simple steps that must be completed before returning your product to Aurora Scientific. 

1. Obtain a Return Material Authorization number (RMA#). 

Go to our website or contact our technical support department to obtain a RMA #.  We require the serial 

number of the product along with your contact information, i.e., your name, institution, phone number 

and email address. 

2. Package your instrument. 

Use the original packaging materials if available. If you do not have original packaging, then ensure that 

the product is wrapped in bubble pack and placed in a sturdy corrugated cardboard box.  

3. Prepare Customs documents. 

Canadian Clients: no customs documents are required, skip to step 4. 

European Clients: no customs documents are required, skip to step 4 and ship to Aurora Scientific 

Europe. 

Asia, Australia and New Zealand Clients: no customs documents are required, skip to step 4 and ship to 

Aurora Scientific Asia. 

USA and Rest of the World Clients: We will supply you with a Commercial Invoice (CI) that must be 

included with the shipment. Please look for the CI in our return email message.  You must sign and date 

the commercial invoice.  

Place three (3) copies of the CI in an envelope and mark the outside CUSTOMS PAPERS ENCLOSED. Attach 

the envelope to the outside of the box. 

4. Choose a shipper and prepare the waybill. 

European Clients: ship your instrument to Aurora Scientific Europe in Dublin, Ireland. 

Asia, Australia and New Zealand Clients: ship your instrument to Aurora Scientific Asia in Hong Kong. 

Canadian, USA and all other Clients: ship your instrument to Aurora Scientific in Ontario, Canada. 

You may ship your instrument back to us via the courier of your choice or via parcel post. If possible, we 

prefer that you ship via FedEx. You are responsible for both the shipping and brokerage charges so please 

mark the waybill accordingly. Please don't ship freight collect. Shipments sent freight collect will be 

received but you will be invoiced for the shipping charges when your instrument is returned. 

5. Prepare and send a purchase order. 

After we receive the instrument, we will evaluate it and contact you with the estimated repair cost. We 

require a purchase order before we can repair and return your instrument. Please fax or email us the 

purchase order at your earliest convenience.  

http://aurorascientific.com/support/instrument-repairs/
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6 Specifications 
 

Model # 470A 

Force Specifications 

Maximum Force1 [µN] 4 

Resolution [nN] 1.0 

AFM Cantilever Specifications 

Force Constant (k) [N/m] 0.2 

Resonant Frequency [Hz] 13,000 

Length (l) [µm] 450 

Width (w) [µm] 50 

Thickness (t) [µm] 2 

Young’s Modulus (E) [N/m2] 169x109 

General Specifications 

Operating Temperature [°C] 0 - 40 

Power Required  100, 120, 220, 240 VAC, 50/60 Hz. available 

Power Consumption [W] 20 

Controller Weight [kg] 2.5 

Head Weight [kg] 5.0 

Controller Dimensions [cm] 21W (1/2 rack mount) x 25D x 9H (2U) 

 
 
 

 
1 For AFM Cantilever supplied with system – other cantilevers will have different maximum forces 


